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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not
place the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface,
such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact the
skin or a soft surface, such as pillows or rugs or clothing, during operation. The device and the AC
adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description HP
ProBook
6555b
Notebook
PC

HP ProBook
6455b
Notebook
PC

HP ProBook
6550b
Notebook
PC

HP ProBook
6450b
Notebook
PC

Product Name HP ProBook 6555b Notebook PC √  

 HP ProBook 6455b Notebook PC  √

 HP ProBook 6550b Notebook PC   √  

 HP ProBook 6450b Notebook PC    √

Processor AMD Phenom II Quad-Core Mobile
Processor N950 (2.1 GHz, 35W, 2
MB L2 cache)

√ √

 AMD Phenom II Quad-Core Mobile
Processor N930 (2.0 GHz/35W/2
MB L2 cache)

√ √

 AMD Phenom II Triple-Core Mobile
Processor N850 (2.2 GHz, 35W,
1.5 MB L2 cache)

√ √

 AMD Phenom II Triple-Core Mobile
Processor N830 (2.1 GHz/35W/
1.5 MB L2 cache)

√ √

 AMD Phenom II Dual-Core Mobile
Processor N640 (2.9 GHz, 35W, 2
MB L2 cache)

√ √

 AMD Phenom II Dual-Core Mobile
Processor N620 (2.8 GHz/35W/2
MB L2 cache)

√ √

 AMD Turion II Dual-Core Mobile
Processor P540 (2.4 GHz, 25W, 2
MB L2 cache)

√ √

 AMD Turion II Dual-Core Mobile
Processor P520 (2.3 GHz/25W/2
MB L2 cache)

√ √

1



Category Description HP
ProBook
6555b
Notebook
PC

HP ProBook
6455b
Notebook
PC

HP ProBook
6550b
Notebook
PC

HP ProBook
6450b
Notebook
PC

 AMD Athlon II Dual-Core Processor
P340 (2.2 GHz, 25W, 1 MB L2
cache)

√ √

 AMD Athlon II Dual-Core Processor
for Notebook PCs P320 (2.1 GHz/
25W/1 MB L2 cache)

√ √

 Intel Core i7-740QM (1.73 GHz
(Turbo up to 2.93), 6 MB L3 cache,
8 threads, 45W)

  √ √

 Intel Core i7-720QM (1.60 GHz
(Turbo up to 2.80 GHz), 6 MB L3
cache, 8 threads, 45 W)

  √ √

 Intel Core i7-620M (2.66 GHz
(Turbo up to 3.33 GHz), 4 MB L3
cache, 4 threads, 35 W)

  √ √

 Intel Core i5-540M (2.53 GHz
(Turbo up to 3.06 GHz), 3 MB L3
cache, 4 threads, 35 W)

  √ √

 Intel Core i5-520M (2.4 GHz (Turbo
up to 2.93 GHz), 3 MB L3 cache, 4
threads, 35 W)

  √ √

 Intel Core i5-450M (2.40 GHz
(Turbo up to 2.66 GHz), 3 MB L3
cache, 4 threads, 35 W)

  √ √

 Intel Core i3-370M (2.40 GHz, 3
MB L3 cache, 35W)

  √ √

 Intel Core i3-350M (2.26 GHz, 3
MB)

  √ √

 Intel P4500 (1.8 GHz), 2MB, 35W   √ √

Chipset AMD M880G RS880M (500 MHz) √ √

 AMD M880G SB820M (D1) √ √

 Intel Calpella   √ √

 Mobile Intel HM57 Chipset   √ √

 Mobile Intel QM57 Chipset   √ √

Graphics ATI Mobility Radeon™ HD 4250
Universal Memory Architecture
(UMA) graphics

√ √

 ATI Mobility Radeon™ HD 540v
UMA graphics

  √ √
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Category Description HP
ProBook
6555b
Notebook
PC

HP ProBook
6455b
Notebook
PC

HP ProBook
6550b
Notebook
PC

HP ProBook
6450b
Notebook
PC

 Supports dual-display ports through
docking station

√ √ √ √

Panels Supports HP Privacy Filter √ √ √ √

 Supports 16×9 aspect ratio display
panels

√ √ √ √

 15.6-in, HD, LED, AntiGlare (AG)
(1366×768)

√  √

 15.6” HD+ LED WVA AG
(1600x900)

√  √

 15.6” HD LED AG (1366x768)
WWAN

√  √

 15.6” HD+ LED WVA AG
(1600x900) WWAN

√  √

 15.6-in, HD, LED, AG (1366×768)
with webcam

√  √

 15.6” HD+ LED WVA AG with
webcam (1600x900)

√  √

 15.6” HD LED AG with webcam
(1366x768) WWAN

√  √

 15.6” HD+ LED WVA AG with
webcam (1600x900) WWAN

√  √

 14.0” HD LED AG (1366x768)  √  √

 14.0” HD LED BrightView (BV)
(1366x768)

   √

 14.0” HD+ LED AG (1600x900)  √  √

 14.0-in, HD, LED, AG (1366x768)
WWAN

   √

 14.0-in, HD, LED, BV (1366x768)
WWAN

   √

 14.0-in, HD+, LED, AG (1600×900)
WWAN

   √

 14.0” HD LED AG with webcam
(1366x768)

 √  √

 14.0” HD LED BV with webcam
(1366x768)

   √

 14.0” HD+ LED AG with webcam
(1600x900)

 √  √
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Category Description HP
ProBook
6555b
Notebook
PC

HP ProBook
6455b
Notebook
PC

HP ProBook
6550b
Notebook
PC

HP ProBook
6450b
Notebook
PC

 14.0” HD LED AG with webcam
(1366x768) WWAN

 √  √

 14.0” HD LED BV with webcam
(1366x768) WWAN

   √

 14.0” HD+ LED AG with webcam
(1600x900) WWAN

 √  √

Memory 2 customer-accessible/upgradable
memory module slots (both slots are
customer-accessible)

√ √ √ √

 Supports up to 8GB √ √ √ √

 Supports the following DDR3,
PC3-10600 configurations at 1333-
MHz in all supported countries and
regions:

√ √ √ √

 8192-MB total system memory
(4096 × 2)

  

 4096-MB total system memory
(4096 × 1)

  

 4096-MB total system memory
(2048 × 2)

  

 3072-MB total system memory
(2048 + 1024)

  

 2048-MB total system memory
(2048 x 1)

  

 2048-MB total system memory
(1024 × 2)

  

 1024-MB total system memory
(1024 × 1)

NOTE: Not available with 64-bit
operating systems or Media Restore.

  

Mass storage
devices

Supports 9.50-mm, 6.35-cm
(2.50-in) hard drives and solid-state
drives

√ √ √ √

 Customer-accessible √ √ √ √

 Supports HP 3D DriveGuard √ √ √ √
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Category Description HP
ProBook
6555b
Notebook
PC

HP ProBook
6455b
Notebook
PC

HP ProBook
6550b
Notebook
PC

HP ProBook
6450b
Notebook
PC

 Supports the following hard drives:

● 500-GB, 7200-rpm

● 320-GB, 7200-rpm SED

● 320-GB, 7200-rpm

● 250-GB, 7200-rpm

● 160-GB, 7200-rpm

√ √ √ √

 Supports 160-GB solid-state drive   √ √

 Supports 128-GB solid-state drive √ √ √ √

Optical drive Single screw removal √ √ √ √

 Customer-accessible √ √ √ √

 Supports 12.70-mm, optical drives √ √ √ √

 Supports no drive option in optical
drive bay with slot bezel

√ √ √ √

 Supports the following optical drives:

● Blu-ray ROM with LightScribe
DVD±RW SuperMulti Double-
Layer Drive

● DVD±RW SuperMulti Double-
Layer Drive with LightScribe

● DVD-ROM Drive

√ √ √ √

 Supports a 500-GB, 7200-rpm hard
drive with cradle

√ √ √ √

Microphone Integrated dual-array digital
microphone only on computer
models equipped with a webcam

√ √ √ √

 Integrated mono digital microphone
only on computer models not
equipped with a webcam

√ √ √ √

Audio IDT 92HD75B high-definition audio √ √ √ √

 Stereo speakers (2) √ √ √ √

Webcam Integrated 2-megapixel camera with
fixed focus

√ √ √ √

Modem 56k v.92 MDC data/fax modem √ √ √ √

 Modem cable not included √ √ √ √
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Category Description HP
ProBook
6555b
Notebook
PC

HP ProBook
6455b
Notebook
PC

HP ProBook
6550b
Notebook
PC

HP ProBook
6450b
Notebook
PC

Ethernet Marvell 88E8059 10/100/1000
network interface card (NIC)

√ √

 82577LC non-vPro (HM57)   √ √

 82577LM vPro (QM57)   √ √

 Intel Ethernet with iAMT   √ √

 NIC Power Down technology √ √ √ √

 S3/S4/S5 wake on LAN (AC mode
only)

√ √ √ √

 Ethernet cable not included √ √ √ √

Wireless Integrated wireless local-area
network (WLAN) options via
MiniCard:

√ √ √ √

 2 WLAN antennas built into the
display assembly

√ √ √ √

 Broadcom 4322 802.11 a/b/g 2 x
2 Half MiniCard

√ √ √ √

 Intel 1000 802.11b/g/n 1 x 2 Half
MiniCard Halogen-Free HMC

  √ √

 Intel 6200 802.11a/g/n 2 x 2 Half
MiniCard HMC

  √ √

 Broadcom BCM94313HMG2L
802.11 b/g/n 1 x 1 Half Minicard

√ √ √ √

 Broadcom 4312 802.11 b/g Half
MiniCard (Russia only)

√ √ √ √

 Supports no-WLAN option √ √ √ √

 Integrated wireless wide-area
network (WWAN) options via
MiniCard:

● Qualcomm HSPA, EVDO-A
MiniCard

● WWAN security provided by
subscriber identity module
(SIM), user-accessible behind
battery

● 2 WWAN antennas
(worldwide, 5-band) built into
the display assembly

√ √ √ √

6 Chapter 1   Product description



Category Description HP
ProBook
6555b
Notebook
PC

HP ProBook
6455b
Notebook
PC

HP ProBook
6550b
Notebook
PC

HP ProBook
6450b
Notebook
PC

 Integrated wireless personal-area
network (WPAN) options via
Bluetooth® module

√ √ √ √

External media
cards

ExpressCard/54 slot √ √ √ √

 Media Card Reader supporting the
following optional digital card
formats:

● Memory Stick

● Memory Stick Pro

● Memory Stick Duo (adapter
required)

● Memory Stick Duo Pro (adapter
required)

● MultiMediaCard

● MultiMediaCard HS

● Secure Digital (SD) Memory
Card

● Secure Digital (SD) High
Capacity Memory Card

● Secure Digital (SD) HS Memory
Card

● xD-Picture Card

√ √ √ √

Docking Docking supported through the HP
Advanced 120W Docking Station
and HP 90W Docking Station

√ √ √ √

Ports 1394a √ √ √ √

 Accessory battery connector √ √ √ √

 VGA, (Dsub 15-pin) supporting
1600 × 1200 external resolution at
75 Hz, hot plug/unplug, and auto
detection for correct output to wide-
aspect vs. standard aspect video

√ √ √ √

 Docking connector √ √ √ √

 Display port √ √ √ √

 Multi-pin AC power √ √ √ √

 RJ-11 (modem) √ √ √ √
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Category Description HP
ProBook
6555b
Notebook
PC

HP ProBook
6455b
Notebook
PC

HP ProBook
6550b
Notebook
PC

HP ProBook
6450b
Notebook
PC

 RJ-45 (Ethernet, includes link and
activity lights)

√ √ √ √

 Serial   √

 Stereo headphone √ √ √ √

 Stereo microphone √ √ √ √

 USB v. 2.0 √ √ √ √

 USB v. 2.0/eSATA combo √ √ √ √

Keyboard/
pointing device

Full-sized keyboard with spill-
resistant design and drains

√ √ √ √

 Supports dual-point (pointing stick
and TouchPad) and TouchPad-only
configurations

 √  √

 Supports dual-point (pointing stick
and TouchPad) and TouchPad-only
configurations with numeric keypad

√  √

 Supports 2-way scroll with legend √ √ √ √

 Taps enabled as default √ √ √ √

Power
requirements

90-W HP Smart Adapter √ √

 90-W PFC EM HP Smart Adapter
(India only)

√ √

 90-W Smart Adapter (discrete only)   √ √

 90-W Smart Adapter (UMA only)   √ √

 Supports multi-pin AC connector and
3-wire plug (with ground pin)

√ √ √ √

 Supports 6-cell Lithium Ion (Li Ion)
battery (47 WH)

  √ √

 Supports 6-cell Lithium Ion (Li Ion)
battery (55 WH)

√ √ √ √

 Supports 9-cell Li Ion battery (93
WH)

NOTE: Does not support HP Fast
Charge.

√ √ √ √

 Supports 6-cell Long Life Battery √ √ √ √

 Supports 8-cell Extended Life Battery √ √ √ √
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Category Description HP
ProBook
6555b
Notebook
PC

HP ProBook
6455b
Notebook
PC

HP ProBook
6550b
Notebook
PC

HP ProBook
6450b
Notebook
PC

 Supports 12-cell Ultra Capacity
Battery

√ √ √ √

 Supports HP Fast Charge
Technology

√ √ √ √

Security Security cable slot √ √ √ √

 Trusted platform module (TPM) 1.2
and TPM enhanced drive lock

√ √ √ √

 Optional HP fingerprint reader √ √  √

 Fingerprint reader with 14.0"
Keyboard Deck

   √

 Fingerprint reader with 15.6"
Keyboard Deck

  √

 Optional active integrated Smart
Card Reader

√ √ √ √

 Full volume encryption √ √ √ √

 Preboot authentication (password
and smart card)

√ √ √ √

 Supports no Fingerprint option √ √ √ √

 Supports no fingerprint reader 14.0"
Keyboard Deck

   √

 Supports no fingerprint reader 15.6"
Keyboard Deck

  √
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Category Description HP
ProBook
6555b
Notebook
PC

HP ProBook
6455b
Notebook
PC

HP ProBook
6550b
Notebook
PC

HP ProBook
6450b
Notebook
PC

Operating
system

Preinstalled without
Microsoft® Office:

● Windows® 7 Home Premium
64

● Windows 7 Home Premium 32

● Windows 7 Pro 64

● Windows 7 Pro 32

● Windows Vista® Business 32

● Windows 7 Professional
(including a downgrade right
to Genuine Windows Vista
Business pre-installed)

● Windows Vista Home Basic 32

● Windows XP Pro 32 with
Windows 7 Pro downgrade

● FreeDOS

● Red Flag Linux

√ √ √ √
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Category Description HP
ProBook
6555b
Notebook
PC

HP ProBook
6455b
Notebook
PC

HP ProBook
6550b
Notebook
PC

HP ProBook
6450b
Notebook
PC

 Preinstalled with Microsoft
Office:

● Windows 7 Home Basic 32

● Windows 7 Home Premium 64

● Windows 7 Home Premium 32

● Windows 7 Pro 64

● Windows 7 Pro 32

● Windows Vista Home Basic 32

● Windows vista Home Basic 32
with PowerPoint Certificate of
Authenticity (COA)

● Windows Vista Business 32

● Windows 7 Professional
(including a downgrade right
to Genuine Windows Vista
Business pre-installed)

● Windows XP Professional
available through downgrade
rights from Windows 7
Professional

√ √ √ √

 Preinstalled with Microsoft
Office Personal, Microsoft
Office Personal with
PowerPoint, and Microsoft
Office Professional:

● Windows 7 Home Premium 64

● Windows 7 Home Premium 32

● Windows 7 Pro 64

● Windows 7 Pro 32

● Windows Vista Business 32

● Windows 7 Professional
(including a downgrade right
to Genuine Windows Vista
Business pre-installed)

● Windows XP Professional
available through downgrade
rights from Windows 7
Professional

√ √ √ √
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Category Description HP
ProBook
6555b
Notebook
PC

HP ProBook
6455b
Notebook
PC

HP ProBook
6550b
Notebook
PC

HP ProBook
6450b
Notebook
PC

 Restore Media (OSDVD):

● Windows 7 Home Basic 32

● Windows 7 Home Premium 64

● Windows 7 Home Premium 32

● Windows 7 Pro 64

● Windows 7 Pro 32

● Windows Vista Business 32

● Windows Vista Home Basic 32

● Windows XP Professional
available through downgrade
rights from Windows 7
Professional

√ √ √ √

 Restore media (DRDVD):

● Windows 7 DRDVD with
Windows DVD

● Windows 7 DRDVD without
Windows DVD

● Windows Vista DRDVD

● Windows XP DRDVD with
Windows 7 downgrade

√ √ √ √

 Restore media (SRDVD):

● Linux - Red Flag

√ √ √ √

 Office restore media: Microsoft
Office ready restore DVD

√ √ √ √

 Certified:

● SuSE Linux

● Microsoft Logo (Windows 7
and Windows Vista Premium)

√ √ √ √
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Category Description HP
ProBook
6555b
Notebook
PC

HP ProBook
6455b
Notebook
PC

HP ProBook
6550b
Notebook
PC

HP ProBook
6450b
Notebook
PC

 Web-only support:

● Windows 7 Enterprise 64

● Windows 7 Enterprise 32

● Windows 7 Ultimate 64

● Windows 7 Ultimate 32

● Windows Vista Enterprise 32

● Windows Vista Enterprise 64

√ √ √ √

Serviceability End-user replaceable parts:

 AC adapter √ √ √ √

 Battery (system) √ √ √ √

 Hard drive √ √ √ √

 Memory module √ √ √ √

 Optical drive √ √ √ √

 SIM √ √ √ √

 WLAN module √ √ √ √

 WPAN module √ √ √ √

 WWAN module √ √ √ √
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2 External component identification

Identifying the hardware
Components included with the computer may vary by region and model. The illustrations in this chapter
identify the standard features on most computer models.

To see a list of hardware installed in the computer, follow these steps:

For Windows 7 and Windows Vista:

1. Select Start > Computer > System Properties.

2. In the left pane, click Device Manager.

You can also add hardware or modify computer configurations using Device Manager.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing applications,
running utilities, or changing Windows settings. Refer to Help and Support for more information.

For Windows XP:

1. Select Start > My Computer.

2. In the left pane of the System Tasks window, click View system information.

3. Select Hardware tab > Device Manager.

You can also add hardware or modify device configurations using Device Manager.
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Top components
Display components

NOTE: Your computer may look slightly different from the illustration in this section.

item Component Description

(1) WWAN antennas (2)* Send and receive wireless signals to communicate with
wireless wide-area networks (WWAN).

(2) Internal microphones (1 or 2, varying by computer model)
†

Record sound.

NOTE: If there is a microphone icon next to each
microphone opening, your computer has internal
microphones.

(3) WLAN antennas (2)* Send and receive wireless signals to communicate with
wireless local area networks (WLAN).

(4) Webcam light (select models only) On: The webcam is in use.

(5) Webcam (select models only) Records audio and video and captures still photographs.

(6) Internal display switch Turns off the display or initiates the Sleep state (Windows
7 and Windows Vista) or Standby (Windows XP) if the
display is closed while the power is on.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antennas free from obstructions.

†Only computers equipped with a webcam are equipped with 2 microphones. Computers not equipped with a webcam are
equipped with only one microphone.
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Keys
NOTE: Refer to the illustration that most closely matches your computer.

Item Component Description

(1) esc key Displays system information when pressed in combination
with the fn key.

(2) fn key Executes frequently used system functions when pressed
in combination with a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Integrated numeric keypad keys Can be used like the keys on an external numeric
keypad.

(6) Function keys Execute frequently used system functions when pressed in
combination with the fn key.
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Item Component Description

(1) esc key Displays system information when pressed in combination
with the fn key.

(2) fn key Executes frequently used system functions when pressed
in combination with a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Embedded numeric keypad keys Can be used like the keys on an external numeric
keypad.

(6) Function keys Execute frequently used system functions when pressed in
combination with the fn key.
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Pointing devices

Item Component Description

(1) Pointing stick (select models only)* Moves the pointer and selects or activates items on the
screen.

(2) Left pointing stick button (select models only)* Functions like the left button on an external mouse.

(3) TouchPad Moves the pointer and selects or activates items on the
screen.

(4) Left TouchPad button* Functions like the left button on an external mouse.

(5) Right pointing stick button* Functions like the right button on an external mouse.

(6) TouchPad scroll zone Scrolls up or down.

(7) Right TouchPad button* Functions like the right button on an external mouse.

*This table describes factory settings. To view or change pointing device preferences:

● In Windows 7 and Windows Vista: Select Start > Control Panel > Hardware and Sound > Mouse.

● In Windows XP: Select Start > Control Panel > Printers and Other Hardware > Mouse.
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Buttons and fingerprint reader
NOTE: Refer to the illustration that most closely matches your computer.

Item Component Description

(1) Power button ● When the computer is off, press the button to turn on
the computer.

● When the computer is on, press the button to shut
down the computer.

● When the computer is in the Sleep state (Windows
7 and Windows Vista) or Standby (Windows XP),
press the button briefly to exit Sleep or Standby.

● When the computer is in Hibernation, press the
button briefly to exit Hibernation.

If the computer has stopped responding and Windows
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the
computer.

To learn more about your power settings, select one of
the following:

● In Windows 7 and Windows Vista: select Start >
Control Panel > System and Maintenance >
Power Options.

● In Windows XP: select Start > Control Panel >
Performance and Maintenance > Power
Options.
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Item Component Description

(2) QuickLook button ● When the computer is off, press the button to open
HP QuickLook.

● When the computer is on, press the button to open
Software Setup.

NOTE: If Software Setup is not available, the default
Web browser opens.

(3) QuickWeb button ● When the computer is off, press the button to open
HP QuickWeb.

● When the computer is on, press the button to open
the default Web browser.

(4) Wireless button Turns the wireless feature on or off but does not establish
a wireless connection.

(5) Volume mute button Mutes and restores speaker sound.

(6) Volume down button Decreases computer volume.

(7) Volume up button Increases computer volume.

(8) Calculator button (select models only) Opens the Windows calculator feature.

(9) Fingerprint reader Allows a fingerprint logon to Windows, instead of a
password logon.
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Item Component Description

(1) Power button ● When the computer is off, press the button to turn on
the computer.

● When the computer is on, press the button to shut
down the computer.

● When the computer is in the Sleep state (Windows
7 and Windows Vista) or Standby (Windows XP),
press the button briefly to exit Sleep or Standby.

● When the computer is in Hibernation, press the
button briefly to exit Hibernation.

If the computer has stopped responding and Windows
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the
computer.

To learn more about your power settings, select one of
the following:

● In Windows 7 and Windows Vista: select Start >
Control Panel > System and Maintenance >
Power Options.

● In Windows XP: select Start > Control Panel >
Performance and Maintenance > Power
Options.

(2) QuickLook button ● When the computer is off, press the button to open
HP QuickLook.

● When the computer is on, press the button to open
Software Setup.

NOTE: If Software Setup is not available, the default
Web browser opens.

(3) QuickWeb button ● When the computer is off, press the button to open
HP QuickWeb.

● When the computer is on, press the button to open
the default Web browser.

(4) Wireless button Turns the wireless feature on or off but does not establish
a wireless connection.

(5) Volume mute button Mutes and restores speaker sound.

(6) Volume down button Decreases computer volume.

(7) Volume up button Increases computer volume.

(8) Fingerprint reader Allows a fingerprint logon to Windows, instead of a
password logon.

Top components 21



Lights
NOTE: Refer to the illustration that most closely matches your computer.

Item Component Description

(1) Wireless lights (2)* ● Blue: An integrated wireless device, such as a
WLAN device, the HP Mobile Broadband Module
(select models only), and/or a Bluetooth device, is
on.

● Amber: All wireless devices are off.

(2) Power lights (2)† ● On: The computer is on.

● Blinking: The computer is in the Sleep state
(Windows 7 and Windows Vista) or Standby
(Windows XP).

● Off: The computer is off or in Hibernation.

(3) Battery light ● Amber: A battery is charging.

● Turquoise: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available
power source has reached a low battery level.
When the battery reaches a critical battery level, the
battery light begins blinking rapidly.

● Off: If the computer is plugged into an external
power source, the light turns off when all batteries in
the computer are fully charged. If the computer is
not plugged into an external power source, the light
stays off until the battery reaches a low battery level.

(4) Drive light ● Blinking turquoise: The hard drive or optical drive
(select models only) is being accessed.

● Amber: HP 3D DriveGuard has temporarily parked
the hard drive.
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Item Component Description

(5) QuickLook light ● On: The computer is on.

● Off: The computer is off or in the Sleep state
(Windows 7 and Windows Vista) or Standby
(Windows XP) or Hibernation.

(6) QuickWeb light On: The Web browser is in use.

(7) Caps lock light On: Caps lock is on.

(8) Num lock light On: Num lock is on or the embedded numeric keypad is
enabled.

(9) Volume mute light ● Turquoise: Speaker sound is on.

● Amber: Speaker sound is off.

(10) Volume down light Blinking: The volume down button is being used to
decrease the speaker volume.

(11) Volume up light Blinking: The volume up button is being used to increase
the speaker volume.

(12) Calculator light On: The Windows calculator function is on.

*The 2 wireless lights display the same information. The light on the wireless button is visible only when the computer is open.
The wireless light on the front of the computer is visible whether the computer is open or closed.

†The 2 power lights display the same information. The light on the power button is visible only when the computer is open. The
power light on the front of the computer is visible whether the computer is open or closed.
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Item Component Description

(1) Wireless lights (2)* ● Blue: An integrated wireless device, such as a
WLAN device, the HP Mobile Broadband Module
(select models only), and/or a Bluetooth device, is
on.

● Amber: All wireless devices are off.

(2) Power lights (2)† ● On: The computer is on.

● Blinking: The computer is in the Sleep state
(Windows 7 and Windows Vista) or Standby
(Windows XP).

● Off: The computer is off or in Hibernation.

(3) Battery light ● Amber: A battery is charging.

● Turquoise: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available
power source has reached a low battery level.
When the battery reaches a critical battery level, the
battery light begins blinking rapidly.

● Off: If the computer is plugged into an external
power source, the light turns off when all batteries in
the computer are fully charged. If the computer is
not plugged into an external power source, the light
stays off until the battery reaches a low battery level.

(4) Drive light ● Blinking turquoise: The hard drive or optical drive
(select models only) is being accessed.

● Amber: HP 3D DriveGuard has temporarily parked
the hard drive.

(5) QuickLook light ● On: The computer is on.

● Off: The computer is off or in the Sleep state
(Windows 7 and Windows Vista) or Standby
(Windows XP) or Hibernation.

(6) QuickWeb light On: The Web browser is in use.

(7) Caps lock light On: Caps lock is on.

(8) Num lock light On: Num lock is on or the embedded numeric keypad is
enabled.

(9) Volume mute light ● Turquoise: Speaker sound is on.

● Amber: Speaker sound is off.

(10) Volume down light Blinking: The volume down button is being used to
decrease the speaker volume.
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Item Component Description

(11) Volume up light Blinking: The volume up button is being used to increase
the speaker volume.

*The 2 wireless lights display the same information. The light on the wireless button is visible only when the computer is open.
The wireless light on the front of the computer is visible whether the computer is open or closed.

†The 2 power lights display the same information. The light on the power button is visible only when the computer is open. The
power light on the front of the computer is visible whether the computer is open or closed.

Front components

item Component Description

(1) Wireless light ● Blue: An integrated wireless device, such as a
wireless local area network (WLAN) device, the HP
Mobile Broadband Module (select models only),
and/or a Bluetooth device, is on.

● Amber: All wireless devices are off.

(2) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state
(Windows 7 and Windows Vista) or Standby
(Windows XP).

● Off: The computer is off or in Hibernation.

(3) Battery light ● Amber: A battery is charging.

● Turquoise: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available
power source has reached a low battery level.
When the battery reaches a critical battery level, the
battery light begins blinking rapidly.

● Off: If the computer is plugged into an external
power source, the light turns off when all batteries in
the computer are fully charged. If the computer is
not plugged into an external power source, the light
stays off until the battery reaches a low battery level.
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item Component Description

(4) Drive light ● Blinking turquoise: The hard drive or optical drive
(select models only) is being accessed.

● Amber: HP 3D DriveGuard has temporarily parked
the hard drive.

(5) Webcam light (select models only) On: The webcam is in use.

(6) Display release latch Opens the computer.

(7) Speakers (2) Produce sound.
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Right-side components
NOTE: Refer to the illustration that most closely matches your computer.

item Component Description

(1) Media Card Reader Supports the following optional digital card formats:

● Memory Stick

● Memory Stick Pro

● Memory Stick Duo (adapter required)

● Memory Stick Duo Pro (adapter required)

● MultiMediaCard

● MultiMediaCard Plus

● Secure Digital (SD) Memory Card

● Secure Digital (SD) High Capacity Memory Card

● micro Secure Digital (SD) Memory Card (adapter
required)

● xD-Picture Card

(2) Upgrade bay Supports an optical drive or a hard drive.

(3) USB port Connects an optional USB device.

(4) 1394 port Connects an optional IEEE 1394 or 1394a device, such
as a camcorder.

(5) Serial port Connects an optional device such as a serial modem,
mouse, or printer.
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item Component Description

(1) Media Card Reader Supports the following optional digital card formats:

● Memory Stick

● Memory Stick Pro

● Memory Stick Duo (adapter required)

● Memory Stick Duo Pro (adapter required)

● MultiMediaCard

● MultiMediaCard Plus

● Secure Digital (SD) Memory Card

● Secure Digital (SD) High Capacity Memory Card

● micro Secure Digital (SD) Memory Card (adapter
required)

● xD-Picture Card

(2) Upgrade bay Supports an optical drive or a hard drive.

(3) USB port Connects an optional USB device.

(4) 1394 port Connects an optional IEEE 1394 or 1394a device, such
as a camcorder.

(5) RJ-11 (modem) jack Connects a modem cable.

(6) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

Left-side components
NOTE: Refer to the illustration that most closely matches your computer.
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item Component Description

(1) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(2) DisplayPort Connects an optional digital display device such as a
high-performance monitor or projector.

(3) USB ports (3) Connect optional USB devices.

(4) ExpressCard slot Supports optional ExpressCards.

(5) Audio-in (microphone) jack Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

(6) Audio-out (headphone) jack Produces sound when connected to optional powered
stereo speakers, headphones, ear buds, a headset, or
television audio.

NOTE: When a device is connected to the headphone
jack, the computer speakers are disabled.

item Component Description

(1) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(2) DisplayPort Connects an optional digital display device such as a
high-performance monitor or projector.

(3) USB ports (3) Connect optional USB devices.
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item Component Description

(4) Smart Card Reader (select models only) Supports optional smart cards and Java™ Cards.

(5) Audio-in (microphone) jack Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

(6) Audio-out (headphone) jack Produces sound when connected to optional powered
stereo speakers, headphones, ear buds, a headset, or
television audio.

NOTE: When a device is connected to the headphone
jack, the computer speakers are disabled.

Rear components
NOTE: Your computer may look slightly different from the illustration in this section.

item Component Description

(1) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

(2) RJ-11 (modem) jack Connects a modem cable.

(3) RJ-45 (network) jack Connects a network cable.

(4) External monitor port Connects an external VGA monitor or projector.

(5) Power connector Connects an AC adapter.

item Component Description

(1) RJ-45 (network) jack Connects a network cable.
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item Component Description

(2) External monitor port Connects an external VGA monitor or projector.

(3) Power connector Connects an AC adapter.
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Bottom components

item Component Description

(1) Battery bay Holds the battery.

(2) SIM slot Contains a wireless subscriber identity module (SIM)
(select models only). The SIM slot is located inside the
battery bay.

(3) Battery release latch Releases the battery from the battery bay.

(4) Docking connector Connects an optional docking device.

(5) Accessory battery connector Connects an optional accessory battery.

(6) Vents (6) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(7) Hard drive bay Holds the hard drive.

(8) Memory module compartment Contains an expansion memory module slot.
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item Component Description

(9) HP Mobile Broadband Module compartment Contains an HP Mobile Broadband Module (select
models only).

NOTE: To prevent an unresponsive system, replace the
wireless module only with a wireless module authorized
for use in the computer by the governmental agency that
regulates wireless devices in your country or region. If
you replace the module and then receive a warning
message, remove the module to restore computer
functionality, and then contact technical support through
Help and Support.

(10) Bluetooth compartment Contains a Bluetooth device.
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3 Illustrated parts catalog

Service tag
When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag:

NOTE: The computer battery must be removed to access the service tag.

(1) Product name: This is the product name affixed to the front of the device.

(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product’s
hardware components. The part number helps a service technician determine what components and
parts are needed.

(4) Warranty period: This number describes the duration of the warranty period for the computer.

(5) Model description: This is the alphanumeric identifier used to locate documents, drivers, and
support for the computer.
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Computer major components

Item Description Spare part number

(1) For models 6555b, 6455b, and 6550b
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Item Description Spare part number

 Display assembly (includes 3 WLAN antenna transceivers and cables, microphones, nameplate, and logo):

 15.6” HD LED AG (1366x768) 613361-001

 15.6” HD+ LED WVA AG (1600x900) 613366-001

 15.6” HD LED AG (1366x768) WWAN 613369-001

 15.6” HD+ LED WVA AG (1600x900) WWAN 613367-001

 15.6” HD LED AG with webcam (1366x768) 613362-001

 15.6” HD+ LED WVA AG with webcam (1600x900) 613368-001

 15.6” HD LED AG with webcam (1366x768) WWAN 613371-001

 15.6” HD+ LED WVA AG with webcam (1600x900) WWAN 613370-001

 14.0” HD LED AG (1366x768) 613372-001

 14.0” HD+ LED AG (1600x900) 613376-001

 14.0” HD LED AG (1366x768) WWAN 613381-001

 14.0” HD+ LED AG (1600x900) WWAN 613379-001

 14.0” HD LED AG with webcam (1366x768) 613373-001

 14.0” HD+ LED AG with webcam (1600x900) 613380-001

 14.0” HD LED AG with webcam (1366x768) WWAN 613383-001

 14.0” HD+ LED AG with webcam (1600x900) WWAN 613382-001

 For models 6450b only

 14.0” HD LED BV (1366x768) 613374-001

 14.0” HD LED BV (1366x768) WWAN 613377-001

 14.0” HD LED BV with webcam (1366x768) 613375-001

 14.0” HD LED BV with webcam (1366x768) WWAN 613378-001

NOTE: See “Display assembly subcomponents” on page 3-10 for display assembly internal component spare part
information.

(2) Switch cover (includes capacitive board and cable):

 For use only with computer models equipped with a 15.6-in display assembly 613342-001

 For use only with computer models equipped with a 14.0-in display assembly 613341-001

(3) Power button board (includes cable) 613310-001

(4) Keyboard (includes keyboard cable):

 For use only with computer models equipped with a 15.6-in display assembly with dual point and a numeric keypad:

 For use in Belgium 613385-A41

 For use in Europe 613385-DW1

 For use in Bulgaria 613385-261
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Item Description Spare part number

 For use in Denmark 613385-081

 For use in the Czech Republic and Slovakia 613385-A81

 For use in France 613385-051

 For use in French Canada 613385-121

 For use in Germany 613385-041

 For use in Greece 613385-DJ1

 For use in Hungary 613385-211

 For use in Iceland 613385-DD1

 For use in Israel 613385-BB1

 For use in Italy 613385-061

 For use in Japan 613385-291

 For use in Korea 613385-AD1

 For use in Latin America 613385-161

 For use in the Netherlands 613385-B31

 For use in Norway 613385-091

 For use in Portugal 613385-131

 For use in Russia 613385-251

 For use in Saudi Arabia 613385-171

 For use in Slovenia 613385-BA1

 For use in Spain 613385-071

 For use in Sweden and Finland 613385-B71

 For use in Switzerland 613385-BG1

 For use in Switzerland 613385-BG1

 For use in Taiwan 613385-AB1

 For use in Thailand 613385-281

 For use in Turkey 613385-141

 For use in the United Kingdom 613385-031

 For use in the United States 613385-001

 For use only with computer models equipped with a 15.6-in display assembly, touchpad, and a numeric keypad:

 For use in Belgium 613386-A41

 For use in Europe 613386-DW1

 For use in Bulgaria 613386-261
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Item Description Spare part number

 For use in Denmark 613386-081

 For use in the Czech Republic and Slovakia 613386-A81

 For use in France 613386-051

 For use in French Canada 613386-121

 For use in Germany 613386-041

 For use in Greece 613386-DJ1

 For use in Hungary 613386-211

 For use in Iceland 613386-DD1

 For use in Israel 613386-BB1

 For use in Italy 613386-061

 For use in Japan 613386-291

 For use in Korea 613386-AD1

 For use in Latin America 613386-161

 For use in the Netherlands 613386-B31

 For use in Norway 613386-091

 For use in Portugal 613386-131

 For use in Russia 613386-251

 For use in Saudi Arabia 613386-171

 For use in Slovenia 613386-BA1

 For use in Spain 613386-071

 For use in Sweden and Finland 613386-B71

 For use in Switzerland 613386-BG1

 For use in Taiwan 613386-AB1

 For use in Thailand 613386-281

 For use in Turkey 613386-141

 For use in the United Kingdom 613386-031

 For use in the United States 613386-001

 For use only with computer models equipped with a 14.0-in display assembly with dual point:

 For use in Belgium 613332-A41

 For use in Europe 613332-DW1

 For use in Bulgaria 613332-261

 For use in Denmark 613332-081
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Item Description Spare part number

 For use in Czech Republic and Slovakia 613332-A81

 For use in France 613332-051

 For use in French Canada 613332-121

 For use in Germany 613332-041

 For use in Greece 613332-DJ1

 For use in Hungary 613332-211

 For use in Hungary 613332-211

 For use in Iceland 613332-DD1

 For use in Israel 613332-BB1

 For use in Italy 613332-061

 For use in Japan 613332-291

 For use in Korea 613332-AD1

 For use in Latin America 613332-161

 For use in Netherlands 613332-B31

 For use in Norway 613332-091

 For use in Latin America 613332-161

 For use in Portugal 613332-131

 For use in Russia 613332-251

 For use in Saudi Arabia 613332-171

 For use in Slovenia 613332-BA1

 For use in Spain 613332-071

 For use in Sweden and Finland 613332-B71

 For use in Switzerland 613332-BG1

 For use in Taiwan 613332-AB1

 For use in Thailand 613332-281

 For use in the United Kingdom 613332-031

 For use in the United States 613332-001

 For use only with computer models equipped with a 14.0-in display assembly and touchpad:

 For use in Belgium 613384-A41

 For use in Europe 613384-DW1

 For use in Bulgaria 613384-261

 For use in Denmark 613384-081
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Item Description Spare part number

 For use in Czech Republic and Slovakia 613384-A81

 For use in France 613384-051

 For use in French Canada 613384-121

 For use in Germany 613384-041

 For use in Greece 613384-DJ1

 For use in Hungary 613384-211

 For use in Iceland 613384-DD1

 For use in Israel 613384-BB1

 For use in Italy 613384-061

 For use in Japan 613384-291

 For use in Korea 613384-AD1

 For use in Netherlands 613384-B31

 For use in Norway 613384-091

 For use in Portugal 613384-131

 For use in Russia 613384-251

 For use in Saudi Arabia 613384-171

 For use in Slovenia 613384-BA1

 For use in Spain 613384-071

 For use in Sweden and Finland 613384-B71

 For use in Switzerland 613384-BG1

 For use in Taiwan 613384-AB1

 For use in Thailand 613384-281

 For use in Turkey 613384-141

 For use in United Kingdom 613384-031

 For use in the United States 613384-001

(5) Palm rest:

 For use only with computer models equipped with a 15.6-in display assembly and a
fingerprint reader (includes fingerprint reader board and cable)

613339-001

 For use only with computer models equipped with a 15.6-in display assembly but not a
fingerprint reader

613340-001

 For use only with computer models equipped with a 14.0-in display assembly and a
fingerprint reader (includes fingerprint reader board and cable)

613338-001

 For use only with computer models equipped with a 14.0-in display assembly but not a
fingerprint reader

613337-001
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Item Description Spare part number

(6) Fan 613349-001

(7) For use only with computer models 6555b and 6455b

Heat sink (includes replacement thermal material)

613399-001

 For use only with computer models 6550b and 6450b

● Intel Heat sink (includes replacement thermal material), discrete

613350-001

 ● Intel Heat sink (includes replacement thermal material), UMA 613351-001

 Plastics Kit:

 For use only with computer models equipped with a 15.6-in display assembly 613343-001

 For use only with computer models equipped with a 14.0-in display assembly 613344-001

 Includes:  

(8a) ExpressCard slot bezel

(8b) Mass storage device cover

(8c) Memory module compartment cover

(8d) Bluetooth module compartment cover

(8e) Wireless module compartment cover

 Optical drive slot bezel (not illustrated)

 NOTE: See “Plastics Kit” on page 3-14 for more Plastics Kit spare part information.

 Cable Kit: 613352-001

 Includes:

(9a) Bluetooth module cable

(9b) Modem module cable (includes RJ-11 connector)

 TouchPad board cable (not illustrated)

 NOTE: See “Cable Kit” on page 3-12 for more Cable Kit spare part information.

(10) Processor (includes replacement thermal material), for use only with computer models 6555b and 6455b:

 AMD Phenom II Quad-Core Mobile Processor N930 (2.0 GHz/35W/2 MB L2 cache) 594169-001

 AMD Phenom II Triple-Core Mobile Processor N830 (2.1 GHz/35W/1.5 MB L2 cache) 594168-001

 AMD Phenom II Dual-Core Mobile Processor N620 (2.8 GHz/35W/2 MB L2 cache) 594166-001

 AMD Turion II Dual-Core Mobile Processor P520 (2.3 GHz/25W/2 MB L2 cache) 594173-001

 AMD Athlon II Dual-Core Processor for Notebook PCs P320 (2.1 GHz/25W/1 MB L2
cache)

594165-001

 For use only with computer models 6550b and 6450b:  

 Intel Core i7-720QM (1.60 GHz (Turbo up to 2.80 GHz), 6 MB L3 cache, 8 threads, 45
W)

603011-001
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Item Description Spare part number

 Intel Core i7-620M (2.66 GHz (Turbo up to 3.33 GHz), 4 MB L3 cache, 4 threads, 35 W) 603010-001

 Intel Core i5-540M (2.53 GHz (Turbo up to 3.06 GHz), 3 MB L3 cache, 4 threads, 35 W) 594646-001

 Intel Core i5-520M (2.4 GHz (Turbo up to 2.93 GHz), 3 MB L3 cache, 4 threads, 35 W) 594645-001

 Intel Core i5-450M (2.40 GHz (Turbo up to 2.66 GHz), 3 MB L3 cache, 4 threads, 35 W) 613585-001

 Intel Core i3-370M (2.40 GHz, 3 MB L3 cache, 35W) 613584-001

 Intel Core i3-350M (2.26 GHz, 3 MB) 595586-001

 Intel P4500 (1.8 GHz), 2MB, 35W 611699-001

(11) TouchPad (includes TouchPad board cable and TouchPad button board cable):

 For use only with computer models equipped with a 15.6-in display assembly 583275-001

 For use only with computer models equipped with a 14.0-in display assembly 583276-001

(12) Memory modules (1333-MHz, DDR3, PC3-10600 shared):

 4096-MB 599092-002

 2048-MB 598856-002

 1024-MB 598859-002

(13) RTC battery (includes cable and double-sided tape) 449137-001

(14) Top cover:

 For use only with computer models equipped with a 15.6-in display assembly and 2-button
touchpad

613335-001

 For use only with computer models equipped with a 15.6-in display assembly and 4-button
touchpad

613336-001

 For use only with computer models equipped with a 14.0-in display assembly and 2-button
touchpad

613333-001

 For use only with computer models equipped with a 14.0-in display assembly and 4-button
touchpad

613334-001

(15) ExpressCard assembly:

 For use only with computer models equipped with a 15.6-in display assembly 613316-001

 For use only with computer models equipped with a 14.0-in display assembly 613315-001

 Smart Card Reader (not illustrated, factory-installed on select models only) 534043-001

 Smart Card Reader HF (not illustrated, factory-installed on select models only) 622597-001

(16) Modem module:

 For use in all countries and regions except Australia and New Zealand 510100-001

 For use only in Australia and New Zealand 510100-011

 NOTE: The modem module spare part kit does not include a modem module cable. The modem module cable is
included in the Cable Kit, spare part numbers 613352-001.
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(17) Speaker assembly (includes cable):

 For use only with computer models equipped with a 15.6-in display assembly 613347-001

 For use only with computer models equipped with a 14.0-in display assembly 613348-001

(18) System board for use only with HP computer models 6555b and 6455b (includes replacement thermal
material):

 AMD UMA 613397-001

 AMD UMA WWAN 613398-001

 AMD UMA, in Russia and China 616787-001

 AMD UMA WWAN, in Russia and China 616788-001

 AMD UMA, in China 616789-001

 AMD UMA WWAN, in China 616790-001

 System board for use only with HP computer models 6550b and 6450b (includes replacement thermal
material):

 Intel Discrete HM57 613296-001

 Intel Discrete HM57 WWAN 613297-001

 Intel Discrete QM57 WWAN 613298-001

 Intel Discrete HM57, in Russia and China 613302-001

 Intel Discrete HM57 WWAN, in Russia and China 613401-001

 Intel Discrete QM57 WWAN, in Russia and China 613303-001

 Intel Discrete HM57, in China 613307-001

 Intel Discrete HM57 WWAN, in China 613308-001

 Intel Discrete QM57 WWAN, in China 613309-001

(19) Optical drive connector board (for use only with computer models equipped with a
15.6-in display assembly)

613314-001

(20) Serial connector and cable (for use only with computer models equipped with a 15.6-in
display assembly)

613313-001

(21) Card reader/USB board (includes cable):

 For use only with computer models equipped with a 15.6-in display assembly 583960-001

 For use only with computer models equipped with a 14.0-in display assembly 583961-001

(22) Base enclosure (includes 7 rubber feet):

 For use only with computer models equipped with a 15.6-in display assembly 613331-001

 For use only with computer models equipped with a 14.0-in display assembly 613330-001

 Latch Kit (not illustrated, includes battery eject arm, latch, and spring) 583239-001
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 Rubber Kit (not illustrated, includes 7 rubber feet, 2 base enclosure screw covers, and 8
display bezel screw covers)

613459-001

(23) Battery:

 9-cell, 93-WH battery 586031-001

 6-cell, 55-WH battery 486296-001

 6-cell, 51-WH battery (for use only with computer models 6555b and 6455b) 593578-001

 6-cell, 47-WH battery (for use only with computer models 6550b and 6450b) 486295-001

(24) Optical drive (includes bezel and bracket):

 Blu-ray ROM with LightScribe DVD±RW SuperMulti Double-Layer Drive 613358-001

 DVD±RW SuperMulti Double-Layer Drive with LightScribe 613360-001

 DVD-ROM Drive 613359-001

 MultiBay hard drive carrier (not illustrated) 583251-001

(25) Mass storage device:

 Hard drive (includes bracket):  

 ● 500-GB, 7200-rpm 613355-001

 ● 320-GB, 7200-rpm 613354-001

 ● 250-GB, 7200-rpm 613353-001

 ● 160-GB, 7200-rpm 620893-001

 ● 128-GB, 2.5-in solid-state drive (includes bracket) 613356-001

 ● 160-GB, 2.5-in solid-state drive (includes bracket), for use only with HP 6550b
and 6450b computer models

613357-001

(26) Bluetooth module 537921-001

 NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth module cable
is included in the Cable Kit, spare part numbers 613352-001.

(27) HSPA EV-DO WWAN module 531993-001

(28) WLAN module:  

 802.11 a/b/g WLAN module:

 ● Broadcom 4322 802.11 a/b/g WLAN module for use in Antigua and Barbuda,
Barbados, Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and
Tobago, the U.S. Virgin Islands, and the United States

582564-001
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 ● Broadcom 4322 802.11 a/b/g WLAN module for use in Afghanistan, Albania,
Algeria, Andorra, Angola, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan,
the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin,
Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British
Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape
Verde, the Central African Republic, Chad, Chile, Colombia, Comoros, the Congo,
Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the
Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equatorial Guinea,
Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia,
Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala,
Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland,
India, Indonesia, Ireland, Italy, the Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan,
Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the
Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius,
Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand,
Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New
Guinea, Paraguay, the People’s Republic of China, Peru, the Philippines, Poland,
Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San
Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra
Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa,
South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent, Suriname,
Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo,
Tonga, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab
Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe

582564-002

 802.11 a/g/n WLAN module:

 ● Intel 6200 802.11a/g/n WLAN module for use in Antigua and Barbuda, Barbados,
Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the
U.S. Virgin Islands, and the United States

581434-001
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 ● Intel 6200 802.11a/g/n WLAN module for use in Afghanistan, Albania, Algeria,
Andorra, Angola, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the
Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda,
Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands,
Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the
Central African Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-
Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia,
Ireland, Italy, the Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati,
Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta,
the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco,
Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether
Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the People’s Republic of
China, Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova,
Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi
Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia,
the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts
and Nevis, St. Lucia, St. Vincent, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Thailand, Togo, Tonga, Tunisia, Turkey, Turkmenistan, Tuvalu,
Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay,
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

581434-002

 Broadcom BCM94313HMG2L 802.11 b/g/n 1 x 1 Half MiniCard 593836-001
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Display assembly components

NOTE: Display assembly subcomponents are available only for standard display assemblies. Flush
glass display assemblies are available only as hinge-up assemblies.

Item Description Spare part
number

(1) Display bezel: 

 For use only with computer models equipped with a 15.6-in display assembly and a
webcam

613322-001

 For use only with computer models equipped with a 15.6-in display assembly but not a
webcam

613321-001

 For use only with computer models equipped with a 14.0-in display assembly and a
webcam

613320-001

 For use only with computer models equipped with a 14.0-in display assembly but not a
webcam

613319-001

48 Chapter 3   Illustrated parts catalog



Item Description Spare part
number

(2) Webcam module: 611026-001

(3) Display Hinge Kit (includes left and right display hinges)

 For use only with computer models equipped with a 15.6-in display assembly 583232-001

 For use only with computer models equipped with a 14.0-in display assembly 583959-001

 Display Cable Kit:  

 For use only with computer models equipped with a 15.6-in HD+ display assembly 583956-001

 For use only with computer models equipped with a 15.6-in HD display assembly 583230-001

 For use only with computer models equipped with a 14.0-in HD display assembly 583231-001

 Includes:  

(4) Display panel cable and webcam cable

(5) WLAN antenna transceivers and cables

(6) Microphones and cables

(7) WWAN antenna transceivers and cables

(8) Display enclosure (includes 3 WLAN antenna transceivers and cables, and 2 WWAN antenna transceivers and
cables)

 For use only with computer models equipped with a 15.6-in display assembly 613325-001

 For use only with computer models equipped with a 14.0-in display assembly 613323-001
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Cable kit

Item Description Spare part number

 Cable kit 613352-001

(1) TouchPad board cable

(2) Bluetooth module cable

(3) Modem module cable (includes RJ-11 connector)
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Mass storage devices

NOTE: Each hard drive spare part kit includes a cable adapter, bracket, and 4 isolators.

Item Description Spare part number

(1) Hard drive (includes bracket):

 500-GB, 7200-rpm 613355-001

 320-GB, 7200-rpm 613354-001

 250-GB, 7200-rpm 613353-001

 160-GB, 7200-rpm 620893-001

(2) 128-GB solid-state drive (includes bracket) 613356-001

 160-GB solid-state drive (includes bracket), for use only with HP 6550b and 6450b
computer models

613357-001

(3) Optical drive: (includes bezel and bracket):

 Blu-ray ROM with LightScribe DVD±RW SuperMulti Double-Layer Drive 613358-001

 DVD±RW SuperMulti Double-Layer Drive with LightScribe 613360-001

 DVD-ROM Drive 613359-001

 MultiBay hard drive carrier (not illustrated) 583251-001
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Plastics kit

Item Description Spare part number

 Plastics Kit:

 For use only with computer models equipped with a 15.6-in display assembly 613343-001

 For use only with computer models equipped with a 14.0-in display assembly 613344-001

(1) ExpressCard slot bezel

(2) Mass storage device cover (includes 2 captive screws)

(3) Memory module compartment cover (includes 1 captive screw)

(4) Bluetooth module compartment cover (includes 1 captive screw)

(5) Wireless module compartment cover (includes 2 captive screws)

(6) Optical drive slot bezel
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Miscellaneous parts
Description Spare part

number

90-W PFC HP Smart Adapter 609940-001

90-W PFC EM HP Smart Adapter 609947-001

Power cord:

For use in Argentina 490371-D01

For use in Brazil 490371-201

For use in Denmark 490371-081

For use in Europe, the Middle East, and Africa 490371-021

For use in Israel 490371-BB1

For use in Italy 490371-061

For use in South Africa 490371-AR1

For use in Switzerland 490371-111

For use in the United Kingdom and Singapore 490371-031

For use in Singapore and the United Kingdom 490371-031

Screw Kit: 583281-001

Hex HM5.0×10.0 screw lock

Phillips PM3.0×3.0 screw

Phillips PM2.5×13.0 captive screw

Phillips PM2.5×11.0 captive screw

Phillips PM2.5×9.0 captive screw

Phillips PM2.5×6.0 screw

Phillips PM2.0×6.0 captive screw

Phillips PM2.0×5.0 screw

Phillips PM2.0×3.0 screw

Slotted Torx T8M2.5×11.0 screw

Slotted Torx T8M2.5×7.0 screw
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Sequential part number listing
Spare part number Description

449137-001 RTC battery (includes cable and double-sided tape)

486296-001 6-cell, 55-WH battery

490371-001 Power cord for use in Canada, Mexico, and the United States

490371-021 Power cord for use in Europe, the Middle East, and Africa

490371-031 Power cord for use in Singapore and the United Kingdom

490371-061 Power cord for use in Italy

490371-081 Power cord for use in Denmark

490371-111 Power cord for use in Switzerland

490371-201 Power cord for use in Brazil

490371-AR1 Power cord for use in South Africa

490371-BB1 Power cord for use in Israel

490371-D01 Power cord for use in Argentia

510100-001 Modem module for use in all countries and regions except Australia and New Zealand

NOTE: The modem module spare part kit does not include a modem module cable. The modem
module cable is included in the Cable Kit, spare part numbers 613352-001 (for use only with
computer models equipped with a 15.6-in display assembly) and 583957-001 (for use only with
computer models equipped with a 14.0-in display assembly).

510100-011 Modem module for use only in Australia and New Zealand

NOTE: The modem module spare part kit does not include a modem module cable. The modem
module cable is included in the Cable Kit, spare part numbers 613352-001 (for use only with
computer models equipped with a 15.6-in display assembly) and 583957-001 (for use only with
computer models equipped with a 14.0-in display assembly).

531993-001 HSPA EV-DO WWAN module

534043-001 Smart Card Reader (factory-installed on select models only)

537921-001 Bluetooth module

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The
Bluetooth module cable is included in the Cable Kit, spare part numbers 613352-001 (for use only
with computer models equipped with a 15.6-in display assembly) and 583957-001 (for use only
with computer models equipped with a 14.0-in display assembly).

581434-001 Intel 6200 802.11 a/g/n WLAN module use in Canada, the Cayman Islands, Guam, Puerto Rico,
the U.S. Virgin Islands, and the United States
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Spare part number Description

581434-002 Intel 6200 802.11 a/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra,
Angola, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, Chile, Colombia,
Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti,
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equatorial Guinea,
Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia,
Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Italy, the Ivory
Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi,
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius,
Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway,
Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the People’s Republic of China,
Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda,
Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra
Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea,
Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan,
Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

582564-001 Broadcom 4312G 802.11b/g WiFi Adapter module for use in Canada, the Cayman Islands,
Guam, Puerto Rico, the U.S. Virgin Islands, and the United States

582564-002 Broadcom 43224 802.11 a/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra,
Angola, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, Chile, Colombia,
Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti,
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equatorial Guinea,
Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia,
Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Italy, the Ivory
Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi,
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius,
Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway,
Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the People’s Republic of China,
Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda,
Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra
Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea,
Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan,
Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

583230-001 Display cable kit for use only with computer models equipped with a 15.6-in HD display assembly

583231-001 For use only with computer models equipped with a 14.0-in HD display assembly

583232-001 Display Hinge Kit for use only with computer models equipped with a 15.6-in display assembly
(includes left and right hinges)
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583239-001 Latch Kit (includes battery eject arm, latch, and spring)

583251-001 MultiBay hard drive carrier

583275-001 TouchPad for use only with computer models equipped with a 15.6-in display assembly (includes
TouchPad board cable and TouchPad button board cable)

583276-001 TouchPad for use only with computer models equipped with a 14.0-in display assembly (includes
TouchPad board cable and TouchPad button board cable)

583281-001 Screw Kit

583956-001 Display cable kit for use only with computer models equipped with a 15.6-in HD+ display assembly

583959-001 Display Hinge Kit for use only with computer models equipped with a 14.0-in display assembly
(includes left and right hinges)

583960-001 Card reader/USB board for use only with computer models equipped with a 15.6-in display
assembly (includes cable)

583961-001 Card reader/USB board for use only with computer models equipped with a 14.0-in display
assembly (includes cable)

586031-001 9-cell, 93-WH battery

593836-001 Broadcom 43224 802.11 a/g/n WLAN module for use in Antigua and Barbuda, Barbados,
Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin
Islands, and the United States

594165-001 AMD Athlon II Dual-Core Processor for Notebook PCs P320 (2.1 GHz/25W/1 MB L2 cache) for
use only with HP 6555b and 6455b computer models (includes replacement thermal material)

594166-001 AMD Phenom II Dual-Core Mobile Processor N620 (2.8 GHz/35W/2 MB L2 cache) for use only
with HP 6555b and 6455b computer models (includes replacement thermal material)

594168-001 AMD Phenom II Triple-Core Mobile Processor N830 (2.1 GHz/35W/1.5 MB L2 cache) for use only
with HP 6555b and 6455b computer models (includes replacement thermal material)

594169-001 AMD Phenom II Quad-Core Mobile Processor N930 (2.0 GHz/35W/2 MB L2 cache) for use only
with HP 6555b and 6455b computer models (includes replacement thermal material)

594173-001 AMD Turion II Dual-Core Mobile Processor P520 (2.3 GHz/25W/2 MB L2 cache) for use only with
HP 6555b and 6455b computer models (includes replacement thermal material)

594645-001 Intel Core i5-520M (2.4 GHz (Turbo up to 2.93 GHz), 3 MB L3 cache, 4 threads, 35 W) for use
only with HP 6550b and 6450b computer models (includes replacement thermal material)

594646-001 Intel Core i5-540M (2.53 GHz (Turbo up to 3.06 GHz), 3 MB L3 cache, 4 threads, 35 W) for use
only with HP 6550b and 6450b computer models (includes replacement thermal material)

595586-001 Intel Core i3-350M (2.26 GHz, 3 MB) for use only with HP 6550b and 6450b computer models
(includes replacement thermal material)

598856-002 2048-MB memory module (1333-MHz, DDR3)

598859-002 1024-MB memory module (1333-MHz, DDR3)

599092-002 4096-MB memory module (1333-MHz, DDR3)

603010-001 Intel Core i7-620M (2.66 GHz (Turbo up to 3.33 GHz), 4 MB L3 cache, 4 threads, 35 W) for use
only with HP 6550b and 6450b computer models (includes replacement thermal material)
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603011-001 Intel Core i7-720QM (1.60 GHz (Turbo up to 2.80 GHz), 6 MB L3 cache, 8 threads, 45 W) for use
only with HP 6550b and 6450b computer models (includes replacement thermal material)

609940-001 90-W PFC HP Smart Adapter

609947-001 90-W PFC EM HP Smart Adapter

611026-001 Webcam module

611699-001 Intel P4500 (1.8 GHz), 2MB, 35W for use only with HP 6550b and 6450b computer models
(includes replacement thermal material)

613302-001 Intel discrete HM57 system board for use only with HP 6550b and 6450b computer models in
Russia and China) (includes replacement thermal material)

613303-001 Intel discrete QM57, WWAN, system board for use only with HP 6550b and 6450b computer
models in Russia and China (includes replacement thermal material)

613307-001 Intel discrete HM57 system board for use only with HP 6550b and 6450b computer models in
China (includes replacement thermal material)

613308-001 Intel discrete HM57, WWAN, system board for use only with HP 6550b and 6450b computer
models in China (includes replacement thermal material)

613309-001 Intel discrete QM57, WWAN, system board for use only with HP 6550b and 6450b computer
models in China (includes replacement thermal material)

613310-001 Power button board (includes cable)

613313-001 Serial connector and cable for use only with computer models equipped with a 15.6-in display
assembly

613314-001 Optical drive connector board (for use only with computer models equipped with a 15.6-in display
assembly)

613315-001 ExpressCard assembly for use only with computer models equipped with a 14.0-in display assembly

613316-001 ExpressCard assembly for use only with computer models equipped with a 15.6-in display assembly

613319-001 Display bezel for use only with computer models equipped with a 14.0-in display assembly but not
a webcam

613320-001 Display bezel for use only with computer models equipped with a 14.0-in display assembly and a
webcam

613321-001 Display bezel for use only with computer models equipped with a 15.6-in display assembly but not
a webcam

613322-001 Display bezel for use only with computer models equipped with a 15.6-in display assembly and a
webcam

613323-001 Display enclosure for use only with computer models equipped with a 14.0-in display assembly and
two microphones (includes 3 WLAN antenna transceivers and cables, and 2 WWAN antenna
transceivers and cables)

613325-001 Display enclosure for use only with computer models equipped with a 15.6-in display assembly
(includes 3 WLAN antenna transceivers and cables, and 2 WWAN antenna transceivers and
cables)

613296-001 Intel discrete HM57 system board for use only with HP 6550b and 6450b computer models
(includes replacement thermal material)
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613297-001 Intel discrete HM57, WWAN, system board for use only with HP 6550b and 6450b computer
models (includes replacement thermal material)

613298-001 Intel discrete QM57, WWAN, system board for use only with HP 6550b and 6450b computer
models (includes replacement thermal material)

613330-001 Base enclosure for use only with computer models equipped with a 14.0-in display assembly
(includes 7 rubber feet)

613331-001 Base enclosure for use only with computer models equipped with a 15.6-in display assembly
(includes 7 rubber feet)

613332-001 Keyboard for use only with computer models equipped with a 14.0-in display assembly with dual
point in the United States (includes keyboard cable)

613332-121 Keyboard for use only with computer models equipped with a 14.0-in display assembly with dual
point in French Canada (includes keyboard cable)

613332-201 Keyboard for use only with computer models equipped with a 14.0-in display assembly with dual
point in Brazil (includes keyboard cable)

613332-161 Keyboard for use only with computer models equipped with a 14.0-in display assembly with dual
point in Latin America (includes keyboard cable)

613333-001 Top cover for use only with computer models equipped with a 14.0-in display assembly and 2-
button touchpad

613334-001 Top cover for use only with computer models equipped with a 14.0-in display assembly and 4-
button touchpad

613335-001 Top cover for use only with computer models equipped with a 15.6-in display assembly and 2-
button touchpad

613336-001 Top cover for use only with computer models equipped with a 15.6-in display assembly and 4-
button touchpad

613337-001 Palm rest for use only with computer models equipped with a 14.0-in display assembly but not a
fingerprint reader

613338-001 Palm rest for use only with computer models equipped with a 14.0-in display assembly and a
fingerprint reader (includes fingerprint reader board and cable)

613339-001 Palm rest for use only with computer models equipped with a 15.6-in display assembly and a
fingerprint reader (includes fingerprint reader board and cable)

613340-001 Palm rest for use only with computer models equipped with a 15.6-in display assembly but not a
fingerprint reader

613341-001 Switch cover for use only with computer models equipped with a 14.0-in display assembly (includes
capacitive board and cable)

613342-001 Switch cover for use only with computer models equipped with a 15.6-in display assembly (includes
capacitive board and cable)

613343-001 Plastics Kit for use only with computer models equipped with a 15.6-in display assembly

NOTE: See “Plastics Kit” on page 3-14 for more Plastics Kit spare part information.

613344-001 Plastics Kit for use only with computer models equipped with a 14.0-in display assembly

NOTE: See “Plastics Kit” on page 3-14 for more Plastics Kit spare part information.
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613347-001 Speaker assembly for use only with computer models equipped with a 15.6-in display assembly
(includes cable)

613348-001 Speaker assembly for use only with computer models equipped with a 14.0-in display assembly
(includes cable)

613349-001 Fan

613352-001 Cable Kit

NOTE: See “Cable Kit” on page 3-12 for more Cable Kit spare part information.

613353-001 250-GB, 7200-rpm hard drive (includes bracket)

613354-001 320-GB, 7200-rpm hard drive (includes bracket)

613355-001 500-GB, 7200-rpm hard drive (includes bracket)

613356-001 128-GB, 2.5-in solid-state drive (includes bracket)

613357-001 160-GB, 2.5-in solid-state drive for use only with HP 6550b and 6450b computer models (includes
bracket)

613358-001 Blu-ray ROM with LightScribe DVD±RW SuperMulti Double-Layer Drive (includes bezel and bracket)

613359-001 DVD-ROM Drive (includes bezel and bracket)

613360-001 DVD±RW and CD-RW SuperMulti Double-Layer Drive (includes bezel and bracket)

613361-001 15.6-in, HD, LED, AG display assembly (1366 x 768) for use only with computer models not
equipped with a webcam (includes 3 WLAN antenna transceivers and cables, microphones,
nameplate, and logo)

613362-001 15.6-in, HD, LED, AG display assembly (1366 x 768) for use only with computer models equipped
with a webcam (includes 3 WLAN antenna transceivers and cables, microphones, nameplate, and
logo)

613366-001 15.6-in, HD+, LED, WVA, AG display assembly (1600 x 900) for use only with computer models
not equipped with a webcam (includes 3 WLAN antenna transceivers and cables, microphones,
nameplate, and logo)

613367-001 15.6-in, HD+, LED, WVA, AG display assembly (1600 x 900), WWAN, for use only with computer
models not equipped with a webcam (includes 3 WLAN antenna transceivers and cables,
microphones, nameplate, and logo)

613368-001 15.6-in, HD+, LED, WVA, AG display assembly (1600 x 900) for use only with computer models
equipped with a webcam (includes 3 WLAN antenna transceivers and cables, microphones,
nameplate, and logo)

613369-001 15.6-in, HD, LED, AG display assembly (1366 x 768), WWAN, for use only with computer models
not equipped with a webcam (includes 3 WLAN antenna transceivers and cables, microphones,
nameplate, and logo)

613370-001 15.6-in, HD+, LED, WVA, AG display assembly (1600 x 900) for use only with computer models
equipped with a webcam and WWAN (includes 3 WLAN antenna transceivers and cables, 2
WWAN antenna transceivers and cables, microphones, nameplate, and logo)

613371-001 15.6-in, HD, LED, AG display assembly (1366 x 768) for use only with computer models equipped
with a webcam and WWAN (includes 3 WLAN antenna transceivers and cables, 2 WWAN
antenna transceivers and cables, microphones, nameplate, and logo)
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613372-001 14.0-in, HD, LED, AG display assembly (1366 x 768) for use only with computer models not
equipped with a webcam (includes 3 WLAN antenna transceivers and cables, 2 WWAN antenna
transceivers and cables, microphones, nameplate, and logo)

613373-001 14.0-in, HD, LED, AG display assembly (1366 x 768) for use only with computer models equipped
with a webcam (includes 3 WLAN antenna transceivers and cables, 2 WWAN antenna transceivers
and cables, microphones, nameplate, and logo)

613374-001 14.0-in, HD, LED, BV display assembly (1366 x 768) for use only with HP 6450b computer models
not equipped with a webcam (includes 3 WLAN antenna transceivers and cables, 2 WWAN
antenna transceivers and cables, microphones, nameplate, and logo)

613375-001 14.0-in, HD, LED, BV display assembly (1366 x 768) for use only with HP 6450b computer models
equipped with a webcam (includes 3 WLAN antenna transceivers and cables, 2 WWAN antenna
transceivers and cables, microphones, nameplate, and logo)

613376-001 14.0-in, HD+, LED, AG, display assembly (1600 x 900) for use only with computer models not
equipped with a webcam (includes 3 WLAN antenna transceivers and cables, 2 WWAN antenna
transceivers and cables, microphones, nameplate, and logo)

613377-001 14.0-in, HD, LED, BV display assembly (1366 x 768), WWAN, for use only with HP 6450b
computer models not equipped with a webcam (includes 3 WLAN antenna transceivers and cables,
2 WWAN antenna transceivers and cables, microphones, nameplate, and logo)

613378-001 14.0-in, HD, LED, BV display assembly (1366 x 768), WWAN, for use only with HP 6450b
computer models equipped with a webcam (includes 3 WLAN antenna transceivers and cables, 2
WWAN antenna transceivers and cables, microphones, nameplate, and logo)

613379-001 14.0-in, HD, LED, AG display assembly for use only with computer models equipped with a
webcam (includes 3 WLAN antenna transceivers and cables, 2 WWAN antenna transceivers and
cables, microphones, nameplate, and logo)

613380-001 14.0-in, HD+, LED, AG display assembly (1600 x 900) for use only with computer models equipped
with a webcam (includes 3 WLAN antenna transceivers and cables, 2 WWAN antenna transceivers
and cables, microphones, nameplate, and logo)

613381-001 14.0-in, HD, LED, AG display assembly for use only with computer models not equipped with a
webcam (includes 3 WLAN antenna transceivers and cables, 2 WWAN antenna transceivers and
cables, microphones, nameplate, and logo)

613382-001 14.0-in, HD+, LED, AG display assembly (1600 x 900) for use only with computer models equipped
with a webcam and WWAN (includes 3 WLAN antenna transceivers and cables, 2 WWAN
antenna transceivers and cables, microphones, nameplate, and logo)

613383-001 14.0-in, HD, LED, AG display assembly (1366 x 768) for use only with computer models equipped
with a webcam and WWAN (includes 3 WLAN antenna transceivers and cables, 2 WWAN
antenna transceivers and cables, microphones, nameplate, and logo)

613384-001 Keyboard for use only with computer models equipped with a 14.0-in display assembly and
touchpad in the United States (includes keyboard cable)

613384-121 Keyboard for use only with computer models equipped with a 14.0-in display assembly and
touchpad in French Canada (includes keyboard cable)

613384-161 Keyboard for use only with computer models equipped with a 14.0-in display assembly and
touchpad in Latin America (includes keyboard cable)

613384-201 Keyboard for use only with computer models equipped with a 14.0-in display assembly and
touchpad in Brazil (includes keyboard cable)
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613385-001 Keyboard for use only with computer models equipped with a 15.6-in display assembly with dual
point and a numeric keypad in the United States (includes keyboard cable)

613385-031 Keyboard for use only with computer models equipped with a 15.6-in display assembly with dual
point and a numeric keypad in the United Kingdom (includes keyboard cable)

613385-041 Keyboard for use only with computer models equipped with a 15.6-in display assembly with dual
point and a numeric keypad in Germany (includes keyboard cable)

613385-051 Keyboard for use only with computer models equipped with a 15.6-in display assembly with dual
point and a numeric keypad in France (includes keyboard cable)

613385-061 Keyboard for use only with computer models equipped with a 15.6-in display assembly with dual
point and a numeric keypad in Italy (includes keyboard cable)

613385-071 Keyboard for use only with computer models equipped with a 15.6-in display assembly with dual
point and a numeric keypad in Spain (includes keyboard cable)

613385-081 Keyboard for use only with computer models equipped with a 15.6-in display assembly with dual
point and a numeric keypad in Denmark (includes keyboard cable)

613385-091 Keyboard for use only with computer models equipped with a 15.6-in display assembly with dual
point and a numeric keypad in Norway (includes keyboard cable)

613385-121 Keyboard for use only with computer models equipped with a 15.6-in display assembly with dual
point and a numeric keypad in French Canada (includes keyboard cable)

613385-131 Keyboard for use only with computer models equipped with a 15.6-in display assembly with dual
point and a numeric keypad in Portugal (includes keyboard cable)

613385-141 Keyboard for use only with computer models equipped with a 15.6-in display assembly with dual
point and a numeric keypad in Turkey (includes keyboard cable)

613385-161 Keyboard for use only with computer models equipped with a 15.6-in display assembly with dual
point and a numeric keypad in Latin America (includes keyboard cable)

613385-171 Keyboard for use only with computer models equipped with a 15.6-in display assembly with dual
point and a numeric keypad in Saudi Arabia (includes keyboard cable)

613385-201 Keyboard for use only with computer models equipped with a 15.6-in display assembly with dual
point and a numeric keypad in Brazil (includes keyboard cable)

613385-211 Keyboard for use only with computer models equipped with a 15.6-in display assembly with dual
point and a numeric keypad in Hungary (includes keyboard cable)

613385-251 Keyboard for use only with computer models equipped with a 15.6-in display assembly with dual
point and a numeric keypad in Russia (includes keyboard cable)

613385-261 Keyboard for use only with computer models equipped with a 15.6-in display assembly with dual
point and a numeric keypad in Bulgaria (includes keyboard cable)

613385-A41 Keyboard for use only with computer models equipped with a 15.6-in display assembly with dual
point and a numeric keypad in Belgium (includes keyboard cable)

613385-A81 Keyboard for use only with computer models equipped with a 15.6-in display assembly with dual
point and a numeric keypad in the Czech Republic and Slovakia (includes keyboard cable)

613385-B31 Keyboard for use only with computer models equipped with a 15.6-in display assembly with dual
point and a numeric keypad in the Netherlands (includes keyboard cable)
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613385-B71 Keyboard for use only with computer models equipped with a 15.6-in display assembly with dual
point and a numeric keypad in Sweden and Finland (includes keyboard cable)

613385-BA1 Keyboard for use only with computer models equipped with a 15.6-in display assembly with dual
point and a numeric keypad in Slovenia (includes keyboard cable)

613385-BB1 Keyboard for use only with computer models equipped with a 15.6-in display assembly with dual
point and a numeric keypad in Israel (includes keyboard cable)

613385-BG1 Keyboard for use only with computer models equipped with a 15.6-in display assembly and a
pointing stick in Switzerland (includes keyboard cable)

613385-DD1 Keyboard for use only with computer models equipped with a 15.6-in display assembly with dual
point and a numeric keypad in Iceland (includes keyboard cable)

613385-DJ1 Keyboard for use only with computer models equipped with a 15.6-in display assembly with dual
point and a numeric keypad in Greece (includes keyboard cable)

613386-001 Keyboard for use only with computer models equipped with a 15.6-in display assembly, touchpad,
and a numeric keypad in the United States (includes keyboard cable)

613386-031 Keyboard for use only with computer models equipped with a 15.6-in display assembly, touchpad,
and a numeric keypad in the United Kingdom (includes keyboard cable)

613386-041 Keyboard for use only with computer models equipped with a 15.6-in display assembly, touchpad,
and a numeric keypad in Germany (includes keyboard cable)

613386-051 Keyboard for use only with computer models equipped with a 15.6-in display assembly, touchpad,
and a numeric keypad in France (includes keyboard cable)

613386-061 Keyboard for use only with computer models equipped with a 15.6-in display assembly, touchpad,
and a numeric keypad in Italy (includes keyboard cable)

613386-071 Keyboard for use only with computer models equipped with a 15.6-in display assembly, touchpad,
and a numeric keypad in Spain (includes keyboard cable)

613386-081 Keyboard for use only with computer models equipped with a 15.6-in display assembly, touchpad,
and a numeric keypad in Denmark (includes keyboard cable)

613386-091 Keyboard for use only with computer models equipped with a 15.6-in display assembly, touchpad,
and a numeric keypad in Norway (includes keyboard cable)

613386-121 Keyboard for use only with computer models equipped with a 15.6-in display assembly, touchpad,
and a numeric keypad in French Canada (includes keyboard cable)

613386-131 Keyboard for use only with computer models equipped with a 15.6-in display assembly, touchpad,
and a numeric keypad in Portugal (includes keyboard cable)

613386-141 Keyboard for use only with computer models equipped with a 15.6-in display assembly, touchpad,
and a numeric keypad in Turkey (includes keyboard cable)

613386-161 Keyboard for use only with computer models equipped with a 15.6-in display assembly, touchpad,
and a numeric keypad in Latin America (includes keyboard cable)

613386-171 Keyboard for use only with computer models equipped with a 15.6-in display assembly, touchpad,
and a numeric keypad in Saudi Arabia (includes keyboard cable)

613386-201 Keyboard for use only with computer models equipped with a 15.6-in display assembly, touchpad,
and a numeric keypad in Brazil (includes keyboard cable)
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613386-211 Keyboard for use only with computer models equipped with a 15.6-in display assembly, touchpad,
and a numeric keypad in Hungary (includes keyboard cable)

613386-251 Keyboard for use only with computer models equipped with a 15.6-in display assembly, touchpad,
and a numeric keypad in Russia (includes keyboard cable)

613386-261 Keyboard for use only with computer models equipped with a 15.6-in display assembly, touchpad,
and a numeric keypad in Bulgaria (includes keyboard cable)

613386-A41 Keyboard for use only with computer models equipped with a 15.6-in display assembly, touchpad,
and a numeric keypad in Belgium (includes keyboard cable)

613386-A81 Keyboard for use only with computer models equipped with a 15.6-in display assembly, touchpad,
and a numeric keypad in the Czech Republic and Slovakia (includes keyboard cable)

613386-B31 Keyboard for use only with computer models equipped with a 15.6-in display assembly, touchpad,
and a numeric keypad in the Netherlands (includes keyboard cable)

613386-B71 Keyboard for use only with computer models equipped with a 15.6-in display assembly, touchpad,
and a numeric keypad in Sweden and Finland (includes keyboard cable)

613386-BA1 Keyboard for use only with computer models equipped with a 15.6-in display assembly, touchpad,
and a numeric keypad in Slovenia (includes keyboard cable)

613386-BB1 Keyboard for use only with computer models equipped with a 15.6-in display assembly, touchpad,
and a numeric keypad in Israel (includes keyboard cable)

613386-BG1 Keyboard for use only with computer models equipped with a 15.6-in display assembly, touchpad,
and a numeric keypad in Switzerland (includes keyboard cable)

613386-DD1 Keyboard for use only with computer models equipped with a 15.6-in display assembly, touchpad,
and a numeric keypad in Iceland (includes keyboard cable)

613386-DJ1 Keyboard for use only with computer models equipped with a 15.6-in display assembly, touchpad,
and a numeric keypad in Greece (includes keyboard cable)

613397-001 AMD UMA system board for use only with HP 6555b and 6455b computer models (includes
replacement thermal material)

613398-001 AMD UMA, WWAN, system board for use only with HP 6555b and 6455b computer models
(includes replacement thermal material)

613399-001 Heat sink for use only with HP 6555b and 6455b computer models (includes replacement thermal
material)

613401-001 Intel discrete HM57, WWAN, system board for use only with HP 6555b and 6455b computer
models in Russia and China (includes replacement thermal material)

613459-001 Rubber Kit (includes 7 rubber feet, 2 base enclosure screw covers, and 8 display bezel screw
covers)

613584-001 Intel Core i3-370M (2.40 GHz, 3 MB L3 cache, 35W) for use only with HP 6550b and 6450b
computer models (includes replacement thermal material)

613585-001 Intel Core i5-450M (2.40 GHz (Turbo up to 2.66 GHz), 3 MB L3 cache, 4 threads, 35 W) for use
only with HP 6550b and 6450b computer models (includes replacement thermal material)

616787-001 AMD UMA system board for use only with HP 6555b and 6455b computer models in Russia and
China (includes replacement thermal material)
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616788-001 AMD UMA, WWAN, system board for use only with HP 6555b and 6455b computer models in
Russia and China (includes replacement thermal material)

616789-001 AMD UMA system board for use only with HP 6555b and 6455b computer models in China
(includes replacement thermal material)

616790-001 AMD UMA, WWAN, system board for use only with HP 6555b and 6455b computer models in
China (includes replacement thermal material)

620893-001 160-GB, 7200-rpm hard drive (includes bracket)

622597-001 Smart Card Reader HF (not illustrated, factory-installed on select models only)
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4 Removal and replacement
procedures

Preliminary replacement requirements
Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Phillips P0 screwdriver

● Phillips P1 screwdriver

● Torx T8 screwdriver

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the device, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic parts. Apply pressure only at the points designated in the maintenance
instructions.
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Cables and connectors

CAUTION: When servicing the device, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the device.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.

Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
device, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the device. If you are unsure whether the device
is off or in Hibernation, turn the device on, and then shut it down through the operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

66 Chapter 4   Removal and replacement procedures



Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the device when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips must
be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 92 screws, in 11 different sizes, that must be removed, replaced, or loosened
when servicing the computer. Make special note of each screw size and location during removal and
replacement.

Service tag
When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag:

NOTE: The computer battery must be removed to access the service tag.

(1) Product name: This is the product name affixed to the front of the device.

(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components and
parts are needed.

(4) Warranty period: This number describes the duration of the warranty period for the device.

(5) Model description: This is the alphanumeric identifier used to locate documents, drivers, and
support for the device.
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Computer feet
The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare part
number 613459-001. There are 7 rubber feet that attach to the base enclosure in the locations shown
in the following illustration.
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Battery

Description Spare part number

9-cell, 93-WH battery 586031-001

6-cell, 55-WH battery 486296-001

6-cell, 51-WH battery (for use only with HP 6555b and 6455b computer models) 593578-001

6-cell, 47-WH battery (for use only with HP 6550b and 6450b computer models) 486295-001

Before removing the battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:

1. Turn the computer upside down on a flat surface, with the front toward you.

2. Slide the battery release latch (1) to release the battery.

3. Remove the battery (2).

Insert the battery into the battery bay until it is seated. The battery release latch automatically locks the
battery into place.

72 Chapter 4   Removal and replacement procedures



SIM
NOTE: The SIM is provided by the end user as a security measure for the WWAN module. The SIM
should be removed, placed into a static-dissipative container, and then replaced when the computer is
reassembled.

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 72).

Remove the SIM:

1. Press in on the SIM (1) to release it from the SIM slot.

2. Remove the SIM (2) from the SIM slot.

Insert the SIM into the SIM slot, and gently push the SIM into the slot until it is firmly seated.
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Bluetooth module
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kit, spare part numbers 613352-001.

Description Spare part
number

Bluetooth module 537921-001

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 72).

5. Remove the accessory cover (see Mass storage device on page 75).

Remove the Bluetooth module:

1. Loosen the Phillips PM2.0×6.0 captive screw (1) that secures the Bluetooth module compartment
cover to the computer.

2. Lift the Bluetooth module compartment cover (2) straight up to remove it. The Bluetooth module
compartment cover is included in the Plastics Kit, spare part numbers 613343-001 (for use only
with computer models equipped with a 15.6-in display assembly) and 613344-001 (for use only
with computer models equipped with a 14.0-in display assembly).
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3. Release the Bluetooth module (1) by lifting the right side of the module out of the Bluetooth module
compartment.

4. Disconnect the Bluetooth module cable (2) from the Bluetooth module.

5. Remove the Bluetooth module (3).

Reverse this procedure to install the Bluetooth module.

Mass storage device
NOTE: The mass storage device spare part kit includes a bracket.

Description Spare part number

Hard drive:

500-GB, 7200-rpm 613355-001

320-GB, 7200-rpm 613354-001

250-GB, 7200-rpm 613353-001

160-GB, 7200-rpm 620893-001

128-GB, 2.5-in solid-state drive
613356-001

160-GB, 2.5-in solid-state drive (for use only with HP 6555b and 6455b computer models
613357-001
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Before removing the mass storage device, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 72).

Remove the mass storage device:

1. Position the computer with the front toward you.

2. Loosen the two Phillips PM2.0×6.0 captive screws (1) that secure the mass storage device cover
to the computer.

3. Lift the left side of the cover (2) to detach it from the computer.

4. Remove the mass storage device cover (3). The mass storage device cover is included in the
Plastics Kit, spare part numbers 613343-001 (for use only with computer models equipped with a
15.6-in display assembly) and 613344-001 (for use only with computer models equipped with a
14.0-in display assembly).

5. Loosen the Phillips PM2.5×13.0 captive screw (1) that secures the mass storage device in the
mass storage device bay.

6. Grasp the Mylar tab (2) on the mass storage device bracket, and slide the mass storage device
(3) to the right to disconnect it from the system board.
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7. Remove the mass storage device (4) from the mass storage device bay.

8. If it is necessary to replace the mass storage device bracket, follow these steps:

a. Remove the four Phillips PM3.0×3.0 screws (1) that secure the mass storage device bracket
to the mass storage device.

b. Lift the bracket (2) straight up to remove it from the mass storage device.

Reverse this procedure to reassemble and install the mass storage device.
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Expansion memory module

Description Spare part number

4096-MB (1333-MHz, DDR3) 599092-002

2048-MB (1333-MHz, DDR3) 598856-002

1024-MB (1333-MHz, DDR3) 598859-002

Before removing the expansion memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 72).

Remove the expansion memory module:

1. Position the computer with the front toward you.

2. Loosen the Phillips PM2.0×6.0 captive screw (1) that secures the memory module compartment
cover to the computer.

3. Lift the left side of the cover (2) to detach it from the computer.

4. Remove the memory module compartment cover (3). The memory module compartment cover is
included in the Plastics Kit, spare part numbers 613343-001 (for use only with computer models
equipped with a 15.6-in display assembly) and 613344-001 (for use only with computer models
equipped with a 14.0-in display assembly).

5. Pull away the retention clips (1) on each side of the memory module to release the memory
module. (The memory module tilts up.)
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CAUTION: To prevent damage to the memory module, hold it by the edges only. Do not touch
the components on the memory module.

6. Grasp the edge of the memory module (2), and then pull it out of the memory module slot.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install the expansion memory module.
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WLAN module

Description Spare part number

802.11 a/b/g WLAN module:

● Broadcom 4322 802.11 a/b/g WLAN module for use in Antigua and Barbuda, Barbados,
Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin
Islands, and the United States

582564-001

● Broadcom 4322 802.11 a/b/g WLAN module for use in Afghanistan, Albania, Algeria,
Andorra, Angola, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas,
Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina
Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, Chile,
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark,
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equatorial
Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia,
Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea,
Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia,
Ireland, Italy, the Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New
Guinea, Paraguay, the People’s Republic of China, Peru, the Philippines, Poland, Portugal,
Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome
and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka,
St. Kitts and Nevis, St. Lucia, St. Vincent, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Thailand, Togo, Tonga, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

582564-002

802.11 a/g/n WLAN module:

● Intel 6200 802.11a/g/n WLAN module for use in Antigua and Barbuda, Barbados, Belize,
Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands,
and the United States

581434-001
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Description Spare part number

● Intel 6200 802.11 a/b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra,
Angola, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso,
Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, Chile,
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark,
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equatorial
Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia,
Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea,
Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia,
Ireland, Italy, the Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New
Guinea, Paraguay, the People’s Republic of China, Peru, the Philippines, Poland, Portugal,
Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome
and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka,
St. Kitts and Nevis, St. Lucia, St. Vincent, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Thailand, Togo, Tonga, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

581434-002

Broadcom BCM94313HMG2L 802.11 b/g/n 1 x 1 Half MiniCard 593836-001

CAUTION: The WWAN module and the WLAN module are not interchangeable.

To prevent an unresponsive system, replace the wireless module only with a wireless module authorized
for use in the computer by the governmental agency that regulates wireless devices in your country or
region. If you replace the module and then receive a warning message, remove the module to restore
computer functionality, and then contact technical support through Help and Support.

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the device by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 72).
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Remove the WLAN module:

1. Position the computer with the front toward you.

NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The
white WLAN antenna cable is connected to the WLAN module “Aux” terminal.

2. Loosen the two Phillips PM2.0×6.0 captive screws (1) that secure the wireless module
compartment cover to the computer.

3. Lift the rear edge of the cover (2) to detach it from the computer.

4. Remove the wireless module compartment cover (3). The wireless module compartment cover is
included in the Plastics Kit, spare part numbers 613343-001 (for use only with computer models
equipped with a 15.6-in display assembly) and 613344-001 (for use only with computer models
equipped with a 14.0-in display assembly).

5. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The
white WLAN antenna cable is connected to the WLAN module “Aux” terminal. If the computer is
equipped with an 802.11a/g/n WLAN module, the yellow WLAN antenna cable (2) is
connected to the middle terminal on the WLAN module.

6. Remove the two Phillips PM2.5×6.0 screws (3) that secure the WLAN module to the system
board. (The WLAN module tilts up.)
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7. Remove the WLAN module (4) by pulling it away from the slot at an angle.

NOTE: WLAN modules are designed with a notch (5) to prevent incorrect insertion of the
WLAN module into the WLAN module slot.

NOTE: If the WLAN antennas are not connected to the terminals on the WLAN module, the protective
sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WLAN module.
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WWAN module

Description Spare part number

HSPA EV-DO WWAN module 531993-001

CAUTION: The WWAN module and the WLAN module are not interchangeable.

To prevent an unresponsive system, replace the wireless module only with a wireless module authorized
for use in the computer by the governmental agency that regulates wireless devices in your country or
region. If you replace the module and then receive a warning message, remove the module to restore
device functionality, and then contact technical support.

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 72).

5. Remove the wireless module compartment cover (see WLAN module on page 80).

Remove the WWAN module:

1. Position the computer with the front toward you.

2. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal.
The blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

3. Remove the two Phillips PM2.5×6.0 screws (2) that secure the WWAN module to the system
board. (The WWAN module tilts up.)
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4. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

NOTE: WWAN modules are designed with a notch (4) to prevent incorrect insertion of the
WWAN module into the WWAN module slot.

NOTE: If the WWAN antennas are not connected to the terminals on the WWAN module, the
protective sleeves must be installed on the antenna connectors, as shown in the following
illustration.

Reverse this procedure to install the WWAN module.
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Optical drive
NOTE: The optical drive spare part kit includes an optical drive bezel and bracket.

Description Spare part number

Blu-ray ROM with LightScribe DVD±RW SuperMulti Double-Layer Drive 613358-001

DVD±RW and CD-RW SuperMulti Double-Layer Drive 613360-001

DVD-ROM Drive 613359-001

MultiBay hard drive carrier 583251-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 72).

Remove the optical drive:

1. Position the computer with the front toward you.

2. Loosen the Phillips PM2.5×11.0 captive screw (1) that secures the optical drive to the computer.

3. Insert a flat-bladed screwdriver or similar tool into the optical drive tab access (2) and press the
tab to the left to release the optical drive from the computer.

4. Remove the optical drive (3) from the optical drive bay.
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5. If it is necessary to replace the optical drive bracket, follow these steps:

a. Position the optical drive with the rear toward you.

b. Remove the three Phillips PM2.0×3.0 screws (1) that secure the optical drive bracket to the
optical drive.

c. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install the optical drive.
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Keyboard
NOTE: The keyboard spare part kit includes a keyboard cable.

For use in country or region: Spare part
number

For use in country or region: Spare part number

Keyboard for use only with computer models equipped with a 15.6-in display assembly with dual point and a numeric keypad:

Belgium 613385-A41 The Netherlands 613385-B31

Brazil 613385-201 Norway 613385-091

Bulgaria 613385-261 Portugal 613385-131

Denmark 613385-DH1 Russia 613385-251

Czech Republic and Slovakia 613385-A81 Saudi Arabia 613385-171

France 613385-051 Latin America 613385-161

French Canada 613385-121 Slovenia 613385-BA1

Germany 613385-041 Spain 613385-071

Greece 613385-DJ1 Sweden and Finland 613385-B71

Hungary 613385-211 Switzerland 613385-BG1

Iceland 613385-DD1 Turkey 613385-141

Israel 613385-BB1 The United Kingdom 613385-031

Italy 613385-061 The United States 613385-001

For use only with computer models equipped with a 15.6-in display assembly, touchpad, and a numeric keypad:

Belgium 613386-A41 The Netherlands 613386-B31

Brazil 613386-201 Norway 613386-091

Bulgaria 613386-261 Portugal 613386-131

Denmark 613386-081 Russia 613386-251

Czech Republic and Slovakia 613386-A81 Saudi Arabia 613386-171

France 613386-051 Latin America 613386-161

French Canada 613386-121 Slovenia 613386-BA1

Germany 613386-041 Spain 613386-071

Greece 613386-DJ1 Sweden and Finland 613386-B71

Hungary 613386-211 Switzerland 613386-BG1

Iceland 613386-DD1 Turkey 613386-141

Israel 613386-BB1 The United Kingdom 613386-031

Italy 613386-061 The United States 613386-001

For use only with computer models equipped with a 14.0-in display assembly with dual point:
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For use in country or region: Spare part
number

For use in country or region: Spare part number

Brazil 613332-201 Latin America 613332-161

French Canada 613332-121 United States 613332-001

For use only with computer models equipped with a 14.0-in display assembly and touchpad:

Brazil 613384-201 Latin America 613384-161

French Canada 613384-121 United States 613384-001

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 72).

Remove the keyboard:

1. Position the computer with the front toward you.

2. Loosen the three Phillips PM2.5×11.0 captive screws that secure the keyboard to the computer.

3. Turn the computer right-side up, with the front toward you.

4. Open the computer as far as it will open.

5. Slide the four keyboard tabs (1) forward.
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6. Lift the rear edge of the keyboard (2), and then swing it up and forward until it rests upside down
on the palm rest.

7. Release the zero insertion force (ZIF) connector to which the pointing stick cable (1) is attached,
and then disconnect the pointing stick cable from the system board.

8. Release the ZIF connector to which the keyboard cable (2) is attached, and then disconnect the
keyboard cable from the system board.

9. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Primary memory module

Description Spare part number

4096-MB (1333-MHz, DDR3) 599092-002

2048-MB (1333-MHz, DDR3) 598856-002

1024-MB (1333-MHz, DDR3) 598859-002

Before removing the primary memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 72).

5. Remove the keyboard (see Keyboard on page 88).

Remove the primary memory module:

1. Position the computer with the front toward you.

2. Pull away the retention clips (1) on each side of the memory module to release the memory
module. (The memory module tilts up.)

CAUTION: To prevent damage to the memory module, hold it by the edges only. Do not touch
the components on the memory module.
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3. Grasp the edge of the memory module (2), and then pull it out of the memory module slot.

NOTE: Memory modules are designed with a notch 3 to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install the primary memory module.
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RTC battery

Description Spare part number

RTC battery (includes cable and double-sided tape) 449137-001

Before removing the real-time clock (RTC) battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 72).

5. Remove the keyboard (see Keyboard on page 88).

Remove the RTC battery:

1. Disconnect the RTC battery cable (1) from the system board.

2. Detach the RTC battery (2) from the clip built into the top cover. (The RTC battery is attached to
the top cover with double-sided tape.)

Reverse this procedure to install the RTC battery. When installing the RTC battery, make sure the “+”
sign faces up.
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Switch cover
NOTE: The switch cover spare part kit includes the capacitive board and cable.

Description Spare part
number

For use only with computer models equipped with a 15.6-in display assembly 613342-001

For use only with computer models equipped with a 14.0-in display assembly 613341-001

Before removing the switch cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 72).

5. Remove the keyboard (see Keyboard on page 88).

Remove the switch cover:

1. Turn the computer upside down, with the front toward you.

2. Remove the three Phillips PM2.0×3.0 screws that secure the switch cover to the computer.

3. Turn the computer display-side up, with the front toward you.

4. Open the computer as far as possible.

5. Release the ZIF connector to which the LED board cable (1) is attached, and then disconnect the
LED board cable from the system board.
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6. Lift the left and right sides of the switch cover (2) until it detaches from the computer.

7. Remove the switch cover.

Reverse this procedure to install the switch cover.
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Power button board

Description Spare part
number

Power button board (includes cable) 613310-001

Before removing the power button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 72).

5. Remove the switch cover (see Switch cover on page 94)

Remove the power button board:

1. Turn the switch cover upside down, with the rear toward you.

2. Release the ZIF connector to which the power button board cable is attached, and then disconnect
the power button board cable (1) from the capacitive board.

3. Remove the two Phillips PM2.0×3.0 screws (2) that secure the power button board to the switch
cover.
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4. Remove the power button board (3) and cable.

Reverse this procedure to install the power button board.
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Palm rest

Description Spare part number

For use only with computer models equipped with a 15.6-in display assembly and a fingerprint
reader (includes fingerprint reader board and cable)

613339-001

For use only with computer models equipped with a 15.6-in display assembly but not a fingerprint
reader

613340-001

For use only with computer models equipped with a 14.0-in display assembly and a fingerprint
reader (includes fingerprint reader board and cable)

613338-001

For use only with computer models equipped with a 14.0-in display assembly but not a fingerprint
reader

613337-001

Before removing the palm rest, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 72).

5. Remove the mass storage device (see Mass storage device on page 75).

Remove the palm rest:

1. Turn the computer upside down, with the front toward you.

2. Remove the two rubber screw covers (1). The rubber screw covers are included in the Rubber Kit,
spare part number 613459-001.

3. Remove the four slotted Torx T8M2.5×7.0 screws (2) that secure the palm rest to the computer.

4. Turn the computer display-side up, with the front toward you.

5. Open the computer as far as possible.
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6. If the computer is equipped with a fingerprint reader, release the ZIF connector to which the
fingerprint reader board cable (1) is attached, and then disconnect the fingerprint reader board
cable (2) from the system board.

7. Lift the front edge of the palm rest (3) until it rests at an angle, and then slide the palm rest
forward (4) until it detaches from the computer.

8. If the computer is equipped with a fingerprint reader, remove the fingerprint reader board cable
from the opening (5) in the top cover.

9. Remove the palm rest.

Reverse this procedure to install the palm rest.
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TouchPad
NOTE: The TouchPad spare part kit includes a TouchPad board cable and TouchPad button board
cable.

Description Spare part number

For use only with computer models equipped with a 15.6-in display assembly 583275-001

For use only with computer models equipped with a 14.0-in display assembly 583276-001

Before removing the TouchPad, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 72).

5. Remove the mass storage device cover (see Mass storage device on page 75).

6. Remove the palm rest (see Palm rest on page 98).

Remove the TouchPad:

1. Lift the rear edge of the TouchPad (1), and swing it up and forward until it rests upside down on
the computer.

2. Release the ZIF connector to which the TouchPad button board cable is attached, and then
disconnect the TouchPad button board cable (2) from the TouchPad board.
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3. Release the ZIF connector to which the TouchPad cable is attached, and then disconnect the
TouchPad cable (3) from the system board.

Reverse this procedure to install the TouchPad.
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Fan

Description Spare part
number

Fan 613349-001

NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the right
side and rear panel of the computer.

The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is
designed to turn on automatically when high temperature conditions exist. These conditions are affected
by high external temperatures, system power consumption, power management/battery conservation
configurations, battery fast charging, and software requirements. Exhaust air is displaced through the
ventilation grill located on the left side of the computer.

Before removing the fan, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 72).

5. Remove the keyboard (see Keyboard on page 88).

6. Remove the switch cover (see Switch cover on page 94).

Remove the fan:

1. Disconnect the fan cable (1) from the system board.

2. Remove the two slotted Torx T8M2.5×7.0 screws (2) that secure the fan to the system board.
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3. Remove the fan (3).

Reverse this procedure to install the fan.
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Heat sink
NOTE: The heat sink spare part kit includes replacement thermal material.

Description Spare part
number

For use only with computer models 6555b and 6455b

Heat sink

613399-001

For use only with computer models 6550b and 6450b  

● Intel Heat sink (includes replacement thermal material), discrete 613350-001

● Intel Heat sink (includes replacement thermal material), UMA 613351-001

Before removing the heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 72).

5. Remove the following components:

a. Keyboard (see Keyboard on page 88)

b. Switch cover (see Switch cover on page 94“)

c. Fan (see Fan on page 102)

Remove the heat sink:

1. Following the 1, 2, 3, 4 sequence stamped into the heat sink, loosen the four Phillips PM2.5×9.0
captive screws (1) that secure the heat sink to the system board.

NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
system board components, it may be necessary to move the heat sink from side to side to detach
it.

2. Lift the right side of the heat sink (2) until it rests at an angle.
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3. Release the heat sink (3) by sliding it up and to the right at an angle.

4. Remove the heat sink.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink and
the system board each time the heat sink is removed:

● Thermal paste is used on the processor (1) and the heat sink section (2) that services it.

● Thermal pads are used on the Northbridge chip (3) and the heat sink section (4) that
services it.

● Thermal pads are used on the Southbridge chip (5) and the heat sink section 6 that services
it.

Replacement thermal material is included with all system board and heat sink spare part kits.
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Reverse this procedure to install the heat sink.
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Processor
NOTE: The processor spare part kit includes replacement thermal material.

Description Spare part number

Processor (includes replacement thermal material) (not illustrated), for use only with computer models 6555b and 6455b:

● AMD Phenom II Quad-Core Mobile Processor N930 (2.0 GHz/35W/2 MB L2 cache) 594169-001

● AMD Phenom II Triple-Core Mobile Processor N830 (2.1 GHz/35W/1.5 MB L2 cache) 594168-001

● AMD Phenom II Dual-Core Mobile Processor N620 (2.8 GHz/35W/2 MB L2 cache) 594166-001

● AMD Turion II Dual-Core Mobile Processor P520 (2.3 GHz/25W/2 MB L2 cache) 594173-001

● AMD Athlon II Dual-Core Processor for Notebook PCs P320 (2.1 GHz/25W/1 MB L2 cache) 594165-001

For use only with computer models 6550b and 6450b:  

● Intel Core i7-720QM (1.60 GHz (Turbo up to 2.80 GHz), 6 MB L3 cache, 8 threads, 45 W) 603011-001

● Intel Core i7-620M (2.66 GHz (Turbo up to 3.33 GHz), 4 MB L3 cache, 4 threads, 35 W) 603010-001

● Intel Core i5-540M (2.53 GHz (Turbo up to 3.06 GHz), 3 MB L3 cache, 4 threads, 35 W) 594646-001

● Intel Core i5-520M (2.4 GHz (Turbo up to 2.93 GHz), 3 MB L3 cache, 4 threads, 35 W) 594645-001

● Intel Core i5-450M (2.40 GHz (Turbo up to 2.66 GHz), 3 MB L3 cache, 4 threads, 35 W) 613585-001

● Intel Core i3-370M (2.40 GHz, 3 MB L3 cache, 35W) 613584-001

● Intel Core i3-350M (2.26 GHz, 3 MB) 595586-001

● Intel P4500 (1.8 GHz), 2MB, 35W 611699-001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 72).

5. Remove the following components:

a. Keyboard (see Keyboard on page 88)

b. Switch cover (see Switch cover on page 94)

c. Fan (see Fan on page 102)

d. Heat sink (see Heat sink on page 104)
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Remove the processor:

1. Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn
counterclockwise, until you hear a click.

2. Lift the processor (2) straight up and remove it.

NOTE: When you install the processor, the gold triangle (3) on the processor must be aligned
with the triangle (4) embossed on the processor socket.

Reverse this procedure to install the processor.
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Display assembly
NOTE: The display assembly spare part kit includes 3 WLAN antenna transceivers and cables,
microphones, nameplate, and logo.

Description Spare part
number

For models 6555b, 6455b, and 6550b  

15.6” HD LED AG (1366x768) 613361-001

15.6” HD+ LED WVA AG (1600x900) 613366-001

15.6” HD LED AG (1366x768) WWAN 613369-001

15.6” HD+ LED WVA AG (1600x900) WWAN 613367-001

15.6” HD LED AG with webcam (1366x768) 613362-001

15.6” HD+ LED WVA AG with webcam (1600x900) 613368-001

15.6” HD LED AG with webcam (1366x768) WWAN 613371-001

15.6” HD+ LED WVA AG with webcam (1600x900) WWAN 613370-001

14.0” HD LED AG (1366x768) 613372-001

14.0” HD+ LED AG (1600x900) 613376-001

14.0” HD LED AG (1366x768) WWAN 613381-001

14.0” HD+ LED AG (1600x900) WWAN 613379-001

14.0” HD LED AG with webcam (1366x768) 613373-001

14.0” HD+ LED AG with webcam (1600x900) 613380-001

14.0” HD LED AG with webcam (1366x768) WWAN 613383-001

14.0” HD+ LED AG with webcam (1600x900) WWAN 613382-001

For models 6450b only  

14.0” HD LED BV (1366x768) 613374-001

14.0” HD LED BV (1366x768) WWAN 613377-001

14.0” HD LED BV with webcam (1366x768) 613375-001

14.0” HD LED BV with webcam (1366x768) WWAN 613378-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.
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4. Remove the battery (see Battery on page 72).

5. Disconnect the antenna cables from the WLAN (see WLAN module on page 80) and WWAN
modules (see WWAN module on page 84).

6. Remove the keyboard (see Keyboard on page 88).

7. Remove the switch cover (see Switch cover on page 94).

Remove the display assembly:

1. Close the computer.

2. Position the computer with the rear panel toward you.

3. Remove the four slotted Torx T8M2.5×11.0 screws that secure the display assembly to the
computer.

4. Turn the computer display-side up, with the front toward you.

5. Open the computer as far as it will open.

6. Disconnect the microphone cable (1) from the system board.

7. Remove the microphone cable from the clips and routing channel (2) built into the top cover.

110 Chapter 4   Removal and replacement procedures



8. Disconnect the display panel cable (3) from the system board.

9. Release the wireless antenna cables from the opening in the top cover (1).

10. Remove the wireless antenna cables from the clips (2) and routing channel built into the top cover.

CAUTION: Support the display assembly when removing the following screws. Failure to
support the display assembly can result in damage to the display assembly and other computer
components.
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11. Remove the two slotted Torx T8M2.5×11.0 screws (1) that secure the display assembly to the
base enclosure.

12. Lift the display assembly (2) straight up and remove it.

13. If it is necessary to replace the display bezel or any of the display assembly internal components:

a. Remove the eight rubber screw covers (1). The rubber screw covers are included in the
Rubber Kit, spare part number 613459-001.

b. Remove the eight Phillips PM2.5×6.0 screws (2) that secure the display bezel to the display
assembly.

c. Slide and hold the display release latch (1) to the right.

d. Flex the inside edges of the top edge (2), the left and right sides (3), and the bottom edge
(4) of the display bezel until the bezel disengages from the display enclosure.
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e. Remove the display bezel (5). The display bezel is available using the following spare part
numbers:

● 613322-001—For use only with computer models equipped with a 15.6-in display
assembly and a webcam

● 613321-001—For use only with computer models equipped with a 15.6-in display
assembly but not a webcam

● 613320-001—For use only with computer models equipped with a 14.0-in display
assembly and a webcam

● 613319-001—For use only with computer models equipped with a 14.0-in display
assembly but not a webcam

NOTE: When installing the display bezel, it may be necessary to replace the double-sided tape
that secures the bezel to the display enclosure. The tape should be installed in the locations shown
in the following illustration.
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14. If it is necessary to replace the webcam module:

a. Release the webcam module (1) as far from the display enclosure as the webcam module
cable allows. (The webcam module is attached to the display enclosure with double-sided
tape.)

b. Disconnect the webcam module cable (2) from the webcam module.

c. Remove the webcam module (3). The webcam module is available using spare part number
611026-001.

15. If it is necessary to replace the display panel cable or display hinges:

a. Remove the two Phillips PM2.5×6.0 screws that secure the display panel to the display
enclosure.

b. Lift the top edge of the display panel (1), and then swing it up and forward until it rests
upside down in front of the display enclosure.

c. Release the support strip (2) and locking bar (3) that secure the display panel cable to the
display panel.
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d. Disconnect the display panel cable (4) from the display panel.

e. Remove the display panel.

f. Release the tabs (1) built into the display enclosure shielding that secure the display panel
cable to the display enclosure.

g. Release the display panel cable from the clips (2) and routing channel built into the bottom
edge of the display enclosure.

h. Remove the display panel cable (3). The display panel cable is included in the Display
Cable Kit, using the following spare part numbers:

● 583956-001–For use only with computer models equipped with a 15.6-in HD+ display
assembly

● 583230-001–For use only with computer models equipped with a 15.6-in HD display
assembly

● 583231-001–For use only with computer models equipped with a 14.0-in HD+ display
assembly
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NOTE: Substeps i and j apply only to computer models equipped with a 15.6-in display
assembly.

i. Remove the eight Phillips PM2.0×3.0 screws (1) that secure the display hinges to the display
panel.

j. Remove the display hinges (2). The display hinges are available in the Display Hinge Kit,
spare part numbers 583232-001 (for use only with computer models equipped with a 15.6-
in display assembly) and 583959-001 (for use only with computer models equipped with a
14.0-in display assembly).

NOTE: Substeps k and l apply only to computer models equipped with a 14.0-in display
assembly.

k. Remove the six Phillips PM2.0×3.0 screws (1) that secure the display hinges to the display
panel.
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l. Remove the display hinges (2). The display hinges are available in the Display Hinge Kit,
spare part numbers 583232-001 (for use only with computer models equipped with a 15.6-
in display assembly) and 583959-001 (for use only with computer models equipped with a
14.0-in display assembly).

m. Remove the two Phillips PM2.0×3.0 screws (1) that secure the display hinge covers to the
display hinges.

n. Remove the display hinge covers (2) by sliding them off of the display hinges. The display
hinge covers are available in the Display Hinge Kit, spare part numbers 583232-001 (for
use only with computer models equipped with a 15.6-in display assembly) and 583959-001
(for use only with computer models equipped with a 14.0-in display assembly).
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16. If it is necessary to replace the WLAN antenna transceivers and cables:

a. Release the tabs (1) built into the display enclosure shielding that secure the WLAN antenna
cables.

b. Detach the WLAN antenna transceivers (2) from the display enclosure. (The transceivers are
attached to the enclosure with double-sided tape.)

c. Remove the WLAN antenna transceivers (3) and cables. The WLAN antenna transceivers
and cables are included in the Display Cable Kit, using the following spare part numbers:

● 583956-001–For use only with computer models equipped with a 15.6-in HD+ display
assembly

● 589230-001–For use only with computer models equipped with a 15.6-in HD display
assembly

● 589231-001–For use only with computer models equipped with a 14.0-in HD display
assembly

17. If it is necessary to replace the WWAN antenna transceivers and cables:

a. Release the tabs (1) built into the display enclosure shielding that secure the WWAN
antenna cables.

b. Detach the WWAN antenna transceivers (2) from the display enclosure. (The transceivers
are attached to the enclosure with double-sided tape.)

c. Remove the WWAN antenna transceivers (3) and cables. The WWAN antenna transceivers
and cables are included in the Display Cable Kit, using the following spare part numbers:

● 583956-001–For use only with computer models equipped with a 15.6-in HD+ display
assembly

● 583230-001–For use only with computer models equipped with a 15.6-in HD display
assembly
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● 583231-001–For use only with computer models equipped with a 14.0-in HD display
assembly

18. If it is necessary to replace the microphones and cables:

a. Release the tabs (1) built into the display enclosure shielding that secure the microphone
cables.

b. Release the microphone receivers from the clips (2) built into the display enclosure.

c. Release the microphone cables from the clips and routing channel (3) built into the bottom
edge of the display enclosure.

d. Remove the microphones and cables (4). The microphones and cables are included in the
Display Cable Kit, using the following spare part numbers:

● 583956-001–For use only with computer models equipped with a 15.6-in HD+ display
assembly

● 583230-001–For use only with computer models equipped with a 15.6-in HD display
assembly
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● 583231-001–For use only with computer models equipped with a 14.0-in HD display
assembly

Reverse this procedure to reassemble and install the display assembly.
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Top cover

Description Spare part number

Top cover for use only with computer models equipped with a 15.6-in display assembly and 2-button
touchpad

613335-001

Top cover for use only with computer models equipped with a 15.6-in display assembly and 4-button
touchpad

613336-001

Top cover for use only with computer models equipped with a 14.0-in display assembly and 2-button
touchpad

613333-001

Top cover for use only with computer models equipped with a 14.0-in display assembly and 4-button
touchpad

613334-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 72).

5. Remove the following components:

● Bluetooth module (see Bluetooth module on page 74)

● Mass storage device (see Mass storage device on page 75)

● Optical drive (see Optical drive on page 86)

● Keyboard (see Keyboard on page 88)

● Switch cover (see Switch cover on page 94)

● Palm rest (see Palm rest on page 98)

● TouchPad (see TouchPad on page 100)

● Display assembly (see Display assembly on page 109)

Remove the top cover.

1. Turn the computer upside down, with the front toward you.
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2. Remove the five slotted Torx T8M2.5×7.0 screws (1) (in the mass storage device bay) and the five
Phillips PM2.0×3.0 screws (2) (in the optical drive and battery bays) that secure the top cover to
the base enclosure.

3. Turn the computer right-side up, with the front toward you.

NOTE: Step 4 applies only to computer models equipped with a 15.6-in display assembly.

4. Remove the nine slotted Torx T8M2.5×7.0 screws (1) and the two slotted Torx T8M2.5×11.0
screws (2) that secure the top cover to the base enclosure.

NOTE: Step 5 applies only to computer models equipped with a 14.0-in display assembly.
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5. Remove the six slotted Torx T8M2.5×7.0 screws (1) and the two slotted Torx T8M2.5×11.0
screws (2) that secure the top cover to the base enclosure.

6. Lift the rear edge (1) of the top cover until it detaches from the base enclosure.

7. Remove the top cover (2) by lifting it straight up.

Reverse this procedure to install the top cover.
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Smart card reader

Description Spare part number

Smart Card Reader (factory-installed on select models only) 534043-001

Smart Card Reader HF (factory-installed on select models only) 622597-001

Before removing the Smart Card Reader, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 72).

5. Remove the following components:

● Bluetooth module (see Bluetooth module on page 74)

● Mass storage device (see Mass storage device on page 75)

● Optical drive (see Optical drive on page 86)

● Keyboard (see Keyboard on page 88)

● Switch cover (see Switch cover on page 94)

● Palm rest (see Palm rest on page 98)

● TouchPad (see TouchPad on page 100)

● Display assembly (see Display assembly on page 109)

Remove the Smart Card Reader:

1. Use a flat-bladed screwdriver (1) to release the hooks (2) on each side of the Smart Card Reader
from the edges of the base enclosure.

2. Press in on the Smart Card Reader (3) to release it from the ExpressCard assembly.
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3. Remove the Smart Card Reader (4) from the ExpressCard assembly.

Reverse this procedure to install the Smart Card reader.
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ExpressCard assembly

Description Spare part number

For use only with computer models equipped with a 15.6-in display assembly 613316-001

For use only with computer models equipped with a 14.0-in display assembly 613315-001

Before removing the ExpressCard assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 72).

5. Remove the following components:

● Bluetooth module (see Bluetooth module on page 74)

● Mass storage device (see Mass storage device on page 75)

● Optical drive (see Optical drive on page 86)

● Keyboard (see Keyboard on page 88)

● Switch cover (see Switch cover on page 94)

● Palm rest (see Palm rest on page 98)

● TouchPad (see TouchPad on page 100)

● Display assembly (see Display assembly on page 109)

● Top cover (see Top cover on page 121)

● Speaker assembly (only on computer models equipped with a 14.0-in display assembly, see
Speakers on page 130)

Remove the ExpressCard assembly:

NOTE: Steps 1 through 3 apply only to computer models equipped with a 15.6-in display assembly.
See steps 4 and 5 for information on removing the ExpressCard assembly on computer models
equipped with a 14.0-in display assembly.

1. Disconnect the speaker cable (1) from the ExpressCard assembly.

2. Lift the right side (2) of the ExpressCard assembly to disconnect it from the system board.

126 Chapter 4   Removal and replacement procedures



3. Remove the ExpressCard assembly (3) by sliding it up and to the right.

NOTE: Steps 4 and 5 apply only to computer models equipped with a 14.0-in display
assembly.

4. Lift the right side (1) of the ExpressCard assembly to disconnect it from the system board.

5. Remove the ExpressCard assembly (2) by sliding it up and to the right.

Reverse this procedure to install the ExpressCard assembly.
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Modem module
NOTE: The modem module spare part kit does not include a modem module cable. The modem
module cable is included in the Cable Kit, spare part numbers 613352-001.

Description Spare part number

For use in all countries and regions except Australia and New Zealand 510100-001

For use only in Australia and New Zealand 510100-011

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 72).

5. Remove the following components:

a. Bluetooth module (see Bluetooth module on page 74)

b. Mass storage device (see Mass storage device on page 75)

c. Optical drive (see Optical drive on page 86)

d. Keyboard (see Keyboard on page 88)

e. Switch cover (see Switch cover on page 94)

f. Palm rest (see Palm rest on page 98)

g. TouchPad (see TouchPad on page 100)

h. Display assembly (see Display assembly on page 109)

i. Top cover (see Top cover on page 121)

Remove the modem module:

1. Remove the Phillips PM2.0×5.0 screw (1) that secures the modem module to the system board.

2. Lift the right side (2) of the modem module to disconnect it from the system board.
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3. Disconnect the modem module cable (3) from the modem module.

Reverse this procedure to install the modem module.

Component replacement procedures 129



Speakers
NOTE: The speaker assembly spare part kit includes a cable.

Description Spare part number

For use only with computer models equipped with a 15.6-in display assembly 613347-001

For use only with computer models equipped with a 14.0-in display assembly 613348-001

Before removing the speakers, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 72).

5. Remove the following components:

a. Bluetooth module (see Bluetooth module on page 74)

b. Mass storage device (see Mass storage device on page 75)

c. Optical drive (see Optical drive on page 86)

d. Keyboard (see Keyboard on page 88)

e. Switch cover (see Switch cover on page 94)

f. Palm rest (see Palm rest on page 98)

g. TouchPad (see TouchPad on page 100)

h. Display assembly (see Display assembly on page 109)

i. Top cover (see Top cover on page 121)

j. ExpressCard assembly (only on computer models equipped with a 15.6-in display assembly,
see ExpressCard assembly on page 126)

Remove the speakers:

NOTE: Steps 1 and 2 apply only to computer models equipped with a 15.6-in display assembly. See
steps 3 through 5 for speaker assembly removal information for computer models equipped with 14.0-
in display assembly.

1. Remove the slotted Torx T8M2.5×7.0 screw (1) that secures the speaker assembly to the base
enclosure.
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2. Remove the speaker assembly (2).

NOTE: Steps 3 through 5 apply only to computer models equipped with a 14.0-in display
assembly.

3. Disconnect the speaker cable (1) from the ExpressCard assembly.

4. Remove the slotted Torx T8M2.5×7.0 screw (2) that secures the speaker assembly to the base
enclosure.

5. Remove the speaker assembly (3).

Reverse this procedure to install the speakers.
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Bluetooth module cable
NOTE: The Bluetooth module cable is included in the Cable Kit, spare part numbers 613352-001.

Before removing the Bluetooth module cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 72).

5. Remove the following components:

a. Bluetooth module (see Bluetooth module on page 74)

b. Mass storage device (see Mass storage device on page 75)

c. Optical drive (see Optical drive on page 86)

d. Keyboard (see Keyboard on page 88)

e. Switch cover (see Switch cover on page 94)

f. Palm rest (see Palm rest on page 98)

g. TouchPad (see TouchPad on page 100)

h. Display assembly (see TouchPad on page 100)

i. Top cover (see Top cover on page 121)

Remove the Bluetooth module cable:

1. Disconnect the Bluetooth module cable (1) from the system board.
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2. Remove the Bluetooth module cable from the clips and routing channel (2) built into the base
enclosure.

Reverse this procedure to install the Bluetooth module cable.
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Card reader/USB board
NOTE: The card reader/USB board spare part kit includes a cable.

Description Spare part
number

For use only with computer models equipped with a 15.6-in display assembly 583960-001

For use only with computer models equipped with a 14.0-in display assembly 583961-001

Before removing the card reader/USB board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power cord.

4. Remove the battery (see Battery on page 72).

5. Remove the following components:

a. Bluetooth module (see Bluetooth module on page 74)

b. Mass storage device (see Mass storage device on page 75)

c. Optical drive (see Optical drive on page 86)

d. Keyboard (see Keyboard on page 88)

e. Switch cover (see Switch cover on page 94)

f. Palm rest (see Palm rest on page 98)

g. TouchPad (see TouchPad on page 100)

h. Display assembly (see Display assembly on page 109)

i. Top cover (see Top cover on page 121)

Remove the card reader/USB board:

1. Release the ZIF connector to which the card reader/USB board cable is attached, and then
disconnect the card reader/USB board cable (1) from the system board.

2. Remove the slotted Torx T8M2.5×7.0 screw (2) that secures the card reader/USB board to the
base enclosure.

3. Lift the left side (3) of the card reader/USB board to release the connectors from the openings in
the base enclosure.
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4. Remove the card reader/USB board by sliding it up and to the left (4).

Reverse this procedure to install the card reader/USB board.
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System board
NOTE: The system board spare part kit includes replacement thermal material.

Description Spare part number

AMD UMA system board for use only with HP 6555b and 6455b computer models 613397-001

AMD UMA, WWAN, system board for use only with HP 6555b and 6455b computer models 613398-001

AMD UMA system board for use only with HP 6555b and 6455b computer models in Russia and
China

616787-001

AMD UMA, WWAN, system board for use only with HP 6555b and 6455b computer models in
Russia and China

616788-001

AMD UMA system board for use only with HP 6555b and 6455b computer models in China 616789-001

AMD UMA, WWAN, system board for use only with HP 6555b and 6455b computer models in
China

616790-001

Intel Discrete HM57 system board for use only with HP 6550b and 6450b computer models 613296-001

Intel Discrete HM57, WWAN, system board for use only with HP 6550b and 6450b computer
models

613297-001

Intel Discrete QM57, WWAN, system board for use only with HP 6550b and 6450b computer
models

613298-001

Intel Discrete HM57 system board for use only with HP 6550b and 6450b computer models in
Russia and China

613302-001

Intel Discrete HM57 WWAN system board for use only with HP 6550b and 6450b computer models
in Russia and China

613401-001

Intel Discrete QM57, WWAN, system board for use only with HP 6550b and 6450b computer
models in Russia and China

613303-001

Intel Discrete HM57 system board for use only with HP 6550b and 6450b computer models in China 613307-001

Intel Discrete HM57, WWAN, system board for use only with HP 6550b and 6450b computer
models in China

613308-001

Intel Discrete QM57, WWAN, system board for use only with HP 6550b and 6450b computer
models in China

613309-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.
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4. Remove the battery (see Battery on page 72).

5. Remove the following components:

a. Bluetooth module (see Bluetooth module on page 74)

b. Mass storage device (see Mass storage device on page 75)

c. Optical drive (see Optical drive on page 86)

d. Keyboard (see Keyboard on page 88)

e. Switch cover (see Switch cover on page 94)

f. Fan (see Fan on page 102)

g. Heat sink (see Heat sink on page 104)

h. Palm rest (see Palm rest on page 98)

i. TouchPad (see TouchPad on page 100)

j. Display assembly (see Display assembly on page 109)

k. Top cover (see Top cover on page 121)

l. ExpressCard assembly (see ExpressCard assembly on page 126)

m. Speaker assembly (see Speakers on page 130)

n. Card reader/USB board (see Card reader/USB board on page 134)

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

● SIM (see SIM on page 73)

● Expansion and primary memory modules (see Expansion memory module on page 78)

● WLAN module (see WLAN module on page 80)

● WWAN module (see WWAN module on page 84)

● RTC battery (see RTC battery on page 93)

● Processor (see Processor on page 107)

● Modem module (see Modem module on page 128)

● Bluetooth module cable (see Bluetooth module cable on page 132)

Remove the system board:

1. Disconnect the following cables:

● Bluetooth module cable (1) from the system board

● Modem module cable (2) from the modem module
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● External monitor cable (3) from the system board

2. Remove the three slotted Torx T8M2.5×7.0 screws (1) and (2) that secure the system board to the
base enclosure. The front-most screw 2 is present only on computer models equipped with a 15.6-
in display assembly.

3. Use the middle of the system board (1) to lift the right side (2) of the system board until it rests at
an angle.
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4. Remove the system board (3) by sliding it away from the base enclosure at an angle.

CAUTION: Do not attempt to remove the optical drive connector board from the system board
until after the system board has been removed from the base enclosure. Failure to follow this
caution can result in damage to the system board and the optical drive connector board.

5. If it is necessary to replace the optical drive connector board, slide the board off of the system
board. The optical drive connector board is available using spare part number 613314-001. The
optical drive connector board is used only with computer models equipped with a 15.6-in display
assembly.

Reverse the procedure to install the system board.
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Serial connector and cable

Description Spare part number

Serial connector and cable for use only with computers equipped with a 15.6-in display assembly 613313-001

Before removing the serial connector and cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 72).

5. Remove the following components:

a. Bluetooth module (see Bluetooth module on page 74)

b. Mass storage device (see Mass storage device on page 75)

c. Optical drive (see Optical drive on page 86)

d. Keyboard (see Keyboard on page 88)

e. Switch cover (see Switch cover on page 94)

f. Fan (see Fan on page 102)

g. Heat sink (see Heat sink on page 104)

h. Palm rest (see Palm rest on page 98)

i. TouchPad (see TouchPad on page 100)

j. Display assembly (see Display assembly on page 109)

k. Top cover (see Top cover on page 121)

l. ExpressCard assembly (see ExpressCard assembly on page 126)

m. Speaker assembly (see Speakers on page 130)

Remove the serial connector and cable:

1. Disconnect the serial connector cable (1) from the system board.

2. Remove the two Hex HM5.0×10.0 screw locks (2) that secure the serial connector to the base
enclosure.
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3. Remove the serial connector (3).

Reverse this procedure to install the serial connector and cable.
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Modem module cable
NOTE: The modem module cable is included in the Cable Kit, spare part numbers 613352-001.

Before removing the modem module cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 72).

5. Remove the following components:

a. Bluetooth module (see Bluetooth module on page 74)

b. Mass storage device (see Mass storage device on page 75)

c. Optical drive (see Optical drive on page 86)

d. Keyboard (see Keyboard on page 88)

e. Switch cover (see Switch cover on page 94)

f. Fan (see Fan on page 102)

g. Heat sink (see Heat sink on page 104)

h. Palm rest (see Palm rest on page 98)

i. TouchPad (see TouchPad on page 100)

j. Display assembly (see Display assembly on page 109)

k. Top cover (see “Top cover” on page 4-49)

l. ExpressCard assembly (see ExpressCard assembly on page 126)

m. Speaker assembly (see Speakers on page 130)

n. Card reader/USB board (see Card reader/USB board on page 134)

o. System board (see System board on page 136)

Remove the modem module cable:

1. Release the RJ-11 connector (1) from the clip built into the base enclosure.

2. Release the modem module cable from the clips (2) and routing channel built into the base
enclosure.
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3. Remove the modem module cable (3).

Reverse this procedure to install the modem module cable.
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5 Computer Setup

Computer Setup in Windows 7
To view the drives installed on the computer, select Start > Computer.

On models with a secondary hard drive (drive D), the optical drive becomes drive E. The next drive
added to the system, such as a new USB drive, will be assigned the next available drive letter.

Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.
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To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, Diagnostics, or System Configuration menu.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore changes and exit, and then press
enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save changes and exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore defaults.
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4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your
computer.

File menu

Select To do this

System Information ● View identification information for the computer and the
batteries in the system.

● View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time Set or change the date and time on the computer.

Restore defaults Replace the configuration settings in Computer Setup with the
original factory settings. (Hard drive mode, password settings,
and security settings are not changed when you restore the
factory settings.)

Ignore changes and exit Cancel any changes entered during the current session. Then
exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Diagnostics menu

Select To do this

System Diagnostics menu ● F1 System Information—Displays the following
information:

◦ Identification information for the computer and the
batteries in the system.

◦ Specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

● F2 Start-up Test—Verifies the system components needed
for starting the computer.

● F3 Run-In Test—Runs a comprehensive check on system
memory.

● F4 Hard Disk Test—Runs a comprehensive self-test on
any hard drive in the system.

● F5 Error Log—Displays a log file if any errors have
occurred.
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System Configuration menu

NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.

Boot Options ● Set a Startup Menu delay (in seconds).

● Enable/disable Custom Logo (disabled by default).

● Enable/disable Display Diagnostic URL (enabled by
default).

● Enable/disable CD-ROM boot (enabled by default).

● Enable/disable SD Card boot (enabled by default).

● Enable/disable floppy boot (enabled by default).

● Enable/disable PXE Internal NIC boot (enabled by
default).

● Set the Express Boot Popup delay in seconds.

● Set the boot order.

Device Configurations ● Enable/disable USB legacy support (enabled by default).
When enabled, USB legacy support allows the following:

◦ Use of a USB keyboard in Computer Setup even
when a Windows® operating system is not running.

◦ Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer.

● Select a parallel port mode: ECP (Enhanced Capabilities
Port), standard, bidirectional, or EPP (Enhanced Parallel
Port).

● Enable/disable fan always on while connected to an AC
outlet (enabled by default).

● Enable/disable LAN Power Save (select models only).
When enabled, saves power by turning off the LAN
when not in use (enabled by default).

● Enable/disable Data Execution Prevention. When
enabled, the processor can disable some virus code
execution, which helps to improve computer security.

● SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:

◦ AHCI (Advanced Host Controller Interface)

◦ IDE (Integrated Drive Electronics)

◦ RAID (select models only)
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Select To do this

NOTE: Availability of the options above varies by
computer model.

● Enable/disable secondary battery fast charge (enabled
by default).

● Enable/disable HP QuickLook 2 (enabled by default).

● Enable/disable Virtualization Technology (select models
only; disabled by default).

● Enable/disable TXT (Intel® Trusted Execution
Technology) (select models only; disabled by default).

● Enable/disable Dual Core CPU (select models only;
enabled by default).

● Enable/Disable Unified Extensible Firmware Interface
(UEFI) mode (disabled by default).

Built-In Device Options ● Enable/disable the wireless button state (enabled by
default).

● Enable/disable embedded WWAN device radio (select
models only; enabled by default).

● Enable/disable embedded Bluetooth® device radio
(enabled by default).

● Enable/disable the Network Interface Controller (LAN)
(enabled by default).

● Set the wake on LAN state. Options include the
following:

◦ Disabled

◦ Boot to Network (set by default)

◦ Follow Boot Order

● Enable/disable the fingerprint device (enabled by
default).

● Enable/disable a modem device (enabled by default).

● Enable/disable the embedded WLAN device (enabled
by default).

● Enable/disable LAN/WLAN switching (disabled by
default).

● Enable the ambient light sensor (enabled by default).

● Enable/disable the Notebook Multibay device (enabled
by default).

● Enable/disable the integrated camera (select models
only; enabled by default).
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Select To do this

Port Options (all are enabled by default) NOTE: All port options are enabled by default.

● Enable/disable the Smart Card slot.

● Enable/disable the ExpressCard slot.

● Enable/disable the serial port.

● Enable/disable the parallel port.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.

● Enable/disable the 1394 port.

AMT Options NOTE: All AMT options are disabled by default.

● Enable/disable Firmware Verbosity.

● Enable/disable AMT Setup Prompt (CTRL-P).

● Enable/disable USB Key Provisioning Support.

● Enable/disable Unconfigure AMT on Next Boot.

● Enable/disable Terminal Emulation Mode

● Enable/disable Firmware Progress Event Support.

● Enable/disable include TYPE-131 in SMBIOS.

Set Security Level Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults Restore the default security settings.
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Computer Setup in Windows Vista
Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, Diagnostics, or System Configuration menu.
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To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore changes and exit, and then press
enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save changes and exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your
computer.

File menu

Select To do this

System Information ● View identification information for the computer and the
batteries in the system.

● View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time Set or change the date and time on the computer.

Restore defaults Replace the configuration settings in Computer Setup with the
original factory settings. (Hard drive mode, password settings,
and security settings are not changed when you restore the
factory settings.)

Ignore changes and exit Cancel any changes entered during the current session. Then
exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.

Computer Setup in Windows Vista 153



Security menu

NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Setup BIOS Administrator Password Set up a BIOS administrator password.

User Management (requires a BIOS administrator password) ● Create a new BIOS user account.

● View a list of ProtectTools users.

Password Policy (requires a BIOS administrator password) Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (disabled by default).

Always Prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (disabled by
default).

Allow Reset of HP ProtectTools security keys Enable/disable reset of HP ProtectTools security keys.

Change Password Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

DriveLock Passwords ● Enable/disable DriveLock on any computer hard drive
(enabled by default).

● Change a DriveLock user password or master password.

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

Automatic DriveLock Enable/disable Automatic DriveLock support.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary
hard drive or the drive in the upgrade bay.

CAUTION: If you run Disk Sanitizer, the data on the
selected drive is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.
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Diagnostics menu

Select To do this

System Diagnostics Menu ● System Information—Displays the following information:

◦ Identification information for the computer and the
batteries in the system.

◦ Specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

● Start-up Test—Verifies the system components needed for
starting the computer.

● Run-In Test—Runs a comprehensive check on system
memory.

● Hard Disk Test—Runs a comprehensive self-test on any
hard drive in the system.

● Error Log—Displays a log file if any errors have
occurred.
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System Configuration menu

NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.

Boot Options ● Set a Startup Menu delay (in seconds).

● Enable/disable Custom Logo (disabled by default).

● Enable/disable Display Diagnostic URL (enabled by
default).

● Enable/disable CD-ROM boot (enabled by default).

● Enable/disable SD Card boot (enabled by default).

● Enable/disable floppy boot (enabled by default).

● Enable/disable PXE Internal NIC boot (disabled by
default).

● Set the Express Boot Popup delay in seconds.

● Set the boot order.

Device Configurations ● Enable/disable USB legacy support (enabled by default).
When enabled, USB legacy support allows the following:

◦ Use of a USB keyboard in Computer Setup even
when a Windows® operating system is not running.

◦ Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer.

● Enable/disable fan always on while connected to an AC
outlet (disabled by default).

● Enable/disable Data Execution Prevention (select models
only; disabled by default). When enabled, the processor
can disable some virus code execution, which helps to
improve computer security.

● SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:

◦ AHCI (Advanced Host Controller Interface)

◦ IDE (Integrated Drive Electronics)
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Select To do this

NOTE: Availability of the options above varies by
computer model.

● Enable/disable HP QuickLook 2 (enabled by default).

● Enable/disable Virtualization Technology (select models
only; disabled by default).

● Enable/disable Dual Core CPU (enabled by default).

● Enable/Disable Unified Extensible Firmware Interface
(UEFI) mode (enabled by default).

Built-In Device Options ● Enable/disable the wireless button state (enabled by
default).

● Enable/disable embedded WWAN device radio
(enabled by default).

● Enable/disable embedded Bluetooth® device radio
(enabled by default).

● Enable/disable the Network Interface Controller (LAN)
(enabled by default).

● Set the wake on LAN state. Options include the
following:

◦ Disabled

◦ Boot to Network (set by default)

◦ Follow Boot Order

● Enable/disable the optical disc drive (enabled by
default).

● Enable/disable the microphone.

● Enable/disable a modem device (enabled by default).

● Enable/disable the embedded WLAN device (enabled
by default).

● Enable/disable LAN/WLAN switching (disabled by
default).

● Enable/disable the integrated camera (select models
only; enabled by default).

Port Options (all are enabled by default) NOTE: All port options are enabled by default.

● Enable/disable the ExpressCard slot.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.
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Select To do this

Set Security Level Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults Restore the default security settings.
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Computer Setup in Windows XP
Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, Diagnostics, or System Configuration menu.
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To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore changes and exit, and then press
enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save changes and exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your
computer.

File menu

Select To do this

System Information ● View identification information for the computer and the
batteries in the system.

● View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time Set or change the date and time on the computer.

Restore defaults Replace the configuration settings in Computer Setup with the
original factory settings. (Hard drive mode, password settings,
and security settings are not changed when you restore the
factory settings.)

Ignore changes and exit Cancel any changes entered during the current session. Then
exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu

NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Setup BIOS Administrator Password Set up a BIOS administrator password.

User Management (requires a BIOS administrator password) ● Create a new BIOS user account.

● View a list of ProtectTools users.

Password Policy (requires a BIOS administrator password) Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (disabled by default).

Always Prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (disabled by
default).

Allow Reset of HP ProtectTools security keys Enable/disable reset of HP ProtectTools security keys.

Change Password Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

DriveLock Passwords ● Enable/disable DriveLock on any computer hard drive
(enabled by default).

● Change a DriveLock user password or master password.

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

Automatic DriveLock Enable/disable Automatic DriveLock support.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary
hard drive or the drive in the upgrade bay.

CAUTION: If you run Disk Sanitizer, the data on the
selected drive is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.
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Diagnostics menu

Select To do this

System Diagnostics Menu ● System Information—Displays the following information:

◦ Identification information for the computer and the
batteries in the system.

◦ Specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

● Start-up Test—Verifies the system components needed for
starting the computer.

● Run-In Test—Runs a comprehensive check on system
memory.

● Hard Disk Test—Runs a comprehensive self-test on any
hard drive in the system.

● Error Log—Displays a log file if any errors have
occurred.
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System Configuration menu

NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.

Boot Options ● Set a Startup Menu delay (in seconds).

● Enable/disable Custom Logo (disabled by default).

● Enable/disable Display Diagnostic URL (enabled by
default).

● Enable/disable CD-ROM boot (enabled by default).

● Enable/disable SD Card boot (enabled by default).

● Enable/disable floppy boot (enabled by default).

● Enable/disable PXE Internal NIC boot (disabled by
default).

● Set the Express Boot Popup delay in seconds.

● Set the boot order.

Device Configurations ● Enable/disable USB legacy support (enabled by default).
When enabled, USB legacy support allows the following:

◦ Use of a USB keyboard in Computer Setup even
when a Windows® operating system is not running.

◦ Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer.

● Enable/disable fan always on while connected to an AC
outlet (disabled by default).

● Enable/disable Data Execution Prevention (select models
only; disabled by default). When enabled, the processor
can disable some virus code execution, which helps to
improve computer security.

● SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:

◦ AHCI (Advanced Host Controller Interface)

◦ IDE (Integrated Drive Electronics)
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Select To do this

NOTE: Availability of the options above varies by
computer model.

● Enable/disable HP QuickLook 2 (enabled by default).

● Enable/disable Virtualization Technology (select models
only; disabled by default).

● Enable/disable Dual Core CPU (enabled by default).

● Enable/Disable Unified Extensible Firmware Interface
(UEFI) mode (enabled by default).

Built-In Device Options ● Enable/disable the wireless button state (enabled by
default).

● Enable/disable embedded WWAN device radio
(enabled by default).

● Enable/disable embedded Bluetooth® device radio
(enabled by default).

● Enable/disable the Network Interface Controller (LAN)
(enabled by default).

● Set the wake on LAN state. Options include the
following:

◦ Disabled

◦ Boot to Network (set by default)

◦ Follow Boot Order

● Enable/disable the optical disc drive (enabled by
default).

● Enable/disable the microphone.

● Enable/disable a modem device (enabled by default).

● Enable/disable the embedded WLAN device (enabled
by default).

● Enable/disable LAN/WLAN switching (disabled by
default).

● Enable/disable the integrated camera (select models
only; enabled by default).

Port Options (all are enabled by default) NOTE: All port options are enabled by default.

● Enable/disable the ExpressCard slot.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.
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Select To do this

Set Security Level Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults Restore the default security settings.
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6 Specifications

Computer specifications
 39.6-cm (15.6-in) models 35.6-cm (14.0-in) models

Dimensions

Depth 24.8 cm (9.76 in) 23.6 cm (9.29 in)

Width 37.1 cm (14.61 in) 33.9 cm (13.35 in)

Height (front to rear) 3.5 to 3.9 cm (1.38 to 1.54
in)

3.4 to 3.9 cm (1.34 to 1.54
in)

Weight   

● With WXGA display assembly, no optical drive,
320-GB, 7200-rpm hard drive, 2.55-AH battery,
1024-MB memory, no modem module, no
Bluetooth module, no WWAN module, no
webcam, and no fingerprint reader

< 2.51 kg (5.53 lb) < 2.26 kg (4.98 lbs)

● With WXGA display assembly, DVD-ROM drive,
320-GB, 7200-rpm hard drive, 2.55-AH battery,
1024-MB memory, no modem module, no
Bluetooth module, no WWAN module, no
webcam, and no fingerprint reader

< 2.64 kg (5.82 lb) < 2.39 kg (5.27 lb )

Input power

Operating voltage 18.5 V dc @ 3.5 A - 65 W or 19.0 V dc @ 4.74 A - 90 W

Operating current 3.5 A or 4.74 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C (32°F to 95°F)

Operating (writing to optical disc) 5°C to 35°C (41°F to 95°F)

Nonoperating -20°C to 60°C (-4°F to 140°F)

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%
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 39.6-cm (15.6-in) models 35.6-cm (14.0-in) models

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m (-50 ft to 10,000 ft)

Nonoperating -15 m to 12,192 m (-50 ft to 40,000 ft)

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this
range of temperatures.

39.6-cm (15.6-in) display specifications
Dimensions  

Height 19.5 cm (7.68 in)

Width 34.1 cm (13.43 in)

Diagonal 39.6 cm (15.59 in)

Number of colors Up to 16.8 million

Contrast ratio 250:1 (typical)

Brightness 200 nits (typical)

Pixel resolution  

Pitch 0.279 × 0.279 mm

Format 1366 × 768

Configuration RGB vertical stripe

Backlight LED

Character display 80 × 25

Total power consumption 4.0 W

Viewing angle ±40° horizontal, +120/-40° vertical (typical)
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35.6-cm (14.0-in) display specifications
Dimensions

Height 17.6 cm (6.93 in)

Width 31.1 cm (12.24 in)

Diagonal 35.7 cm (14.06 in)

Number of colors Up to 16.8 million

Contrast ratio 250:1 (typical)

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.279 × 0.279 mm

Format 1366 × 768

Configuration RGB vertical stripe

Backlight LED

Character display 80 × 25

Total power consumption 4.0 W

Viewing angle ±40° horizontal, +120/-40° vertical (typical)
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Hard drive specifications
 500-GB* 320-GB* 250-GB* 160-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm 70 mm

Weight 101 g 101 g 101 g 101 g

Interface type SATA SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 1.0 ms 1.5 ms 2.0 ms 2.0 ms

Average 14.0 ms 12.0 ms 12.0 ms 12.0 ms

Maximum 22.0 ms 22.0 ms 22.0 ms 22.0 ms

Logical blocks 976,773,168 625,142,448 488,397,168 312,581,808

Disc rotational speed 7200 rpm 7200 rpm 7200 rpm 7200 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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Blu-ray ROM DVD±RW SuperMulti Double-Layer
Drive specifications

Applicable disc  

Read BD-ROM, BD-ROM-DL, BD-R, BD-R-DL, BD-RE, BD-RE-DL, DVD-ROM, DVD+R,
DVD+R-DL, DVD+RW, DVD-R, DVD-R-DL, DVD-RW, DVD-RAM (Ver.2), CD-
DA, CD-ROM (mode 1 and mode 2), CD-ROM XA (mode 2, form 1 and
form 2), Photo CD (single and multiple sessions), CD Extra, CD-R, CD-RW,
and CD-TEXT

Write DVD-RAM (Ver.2), DVD+R, DVD-R, CD-R, and CD-ROM

Random access time  

BD < 230 ms

DVD < 180 ms

Cache buffer 4.5 MB

Data transfer rate

2X BD-RAM 9 MB/sec

8X DVD 2,400 KB/sec

16X CD-R 2,400 KB/sec

16X CD-RW 2,400 KB/sec
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DVD±RW and CD-RW SuperMulti Double-Layer Drive
specifications

Applicable disc  

Read CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CDROM, CD-ROM XA, MIXED MODE
CD, CD-I, CD-I Bridge (Photo-CD, Video CD), Multisession CD (Photo-CD,
CD-EXTRA, Portfolio, CD-R, CD-RW), CD-R, CD-RW, DVD-ROM (DVD-5,
DVD-9, DVD-10, DVD-18), DVD-R, DVD-RW, DVD+R, DVD+RW, DVD-RAM

Write CD-R and CD-RW DVD+R, DVD+RW, DVD-R, DVD-RW, DVD-RAM

Random access time  

DVD < 230 ms

CD < 175 ms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

Transfer mode Multiword DMA Mode
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DVD ROM Drive specifications
Applicable disc  

Read CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-ROM, CD-ROM XA, MIXED MODE
CD, CD-I, CD-I Bridge (Photo-CD, Video CD), Multisession CD (Photo-CD,
CDEXTRA, Portfolio, CD-R, CD-RW), CDR, CD-RW, DVD-ROM (DVD-5,
DVD-9, DVD-10, DVD-18), DVD-R, DVD-RW, DVD+R, DVD+RW, DVD-RAM

Write CD-R and CD-RW

Random access time

DVD < 130 ms

CD < 110 ms

Cache buffer 2 MB

Data transfer rate

CD-R (24X) 3600 KB/s (150 KB/s at 1X CD rate)

CD-RW (24X) 3600 KB/s (150 KB/s at 1X CD rate)

CD-ROM (24X) 3600 KB/s (150 KB/s at 1X CD rate)

DVD (8X) 10,800 KB/s (1,352 KB/s at 1X DVD rate)
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7 Backup and recovery

Windows 7 backup and recovery
To protect your information, use Windows® Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only), or
create system restore points. In case of system failure, you can use the backup files to restore the
contents of your computer.

Windows Backup and Restore provides the following options:

● Creating a system repair disc (select models only)

● Backing up individual files and folders

● Creating a system image (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up
Recovery after a system failure is as complete as your most current backup. You should create system
repair discs (select models only) and your initial backup immediately after software setup. As you add
new software and data files, you should continue to back up your system on a regular basis to maintain
a reasonably current backup. The system repair discs (select models only) are used to start up (boot) the
computer and repair the operating system in case of system instability or failure. Your initial and
subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.
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Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit>Paste.

The screen image is added to the document.

4. Save the document.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on the
type of optical drive installed in your computer.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore, follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start>All Programs>Maintenance>Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).

NOTE: Windows® includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.
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Recovering
In case of system failure or instability, the computer provides the following tools to recover your files.

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools: You can use f11 recovery tools to recover your original hard drive image. The
image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair discs
you previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system.

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled. Personal files must be restored from a
backup.

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. select Start, right-click
Computer, click Manage, and then click Disk Management.

NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 7 Operating System Operating System DVD and the Driver
Recovery disc (both purchased separately). For additional information, contact technical support
by selecting Start > Help and Support > Contact support.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press f11 for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

NOTE: Windows 7 provides additional recovery tools through the operating system. For additional
information, go to Help and Support.

NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows 7
Operating System DVD to reboot the computer and repair the operating system. For additional
information, contact technical support by selecting Start>Help and Support>Contact support.
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Backup and recovery in Windows Vista
Overview

To protect your information, use the Backup and Restore Center to back up individual files and folders,
back up your entire hard drive (select models only), or create system restore points. In case of system
failure, you can use the backup files to restore the contents of your computer.

The Backup and Restore Center provides the following options:

● Backing up individual files and folders

● Backing up the entire hard drive (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information 
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents folder, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.
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3. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

4. Save the document.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on the
type of optical drive installed in your computer.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore Center, follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your files.

NOTE: Windows® includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Performing a recovery 
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use the Backup and Restore Center to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows Vista®
operating system DVD to reboot the computer and repair the operating system. For additional
information, refer to the “Using a Windows Vista operating system DVD (purchased separately)”
section in this guide.

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:

1. Click Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your files.
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NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.

To recover your information using Startup Repair, follow these steps:

CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive.
All files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition. To find
the partitions, select Start > Computer.

NOTE: If the Windows partition and the HP Recovery partition have been deleted, you must
recover your operating system and programs using the Windows Vista operating system DVD and
the Driver Recovery disc (both purchased separately). For additional information, refer to the
“Using a Windows Vista operating system DVD (purchased separately)” section in this guide.

3. Restart the computer, and then press f8 before the Windows operating system loads.

4. Select Repair your computer.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11, follow these steps:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select Start
> Computer.

NOTE: If the HP Recovery partition has been deleted, you must recover your operating system
and programs using the Windows Vista operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows Vista operating
system DVD (purchased separately)” section in this guide.

3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Using a Windows Vista operating system DVD (purchased
separately)

If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating
system DVD to reboot the computer and repair the operating system. Make sure that your most recent
backup (stored on discs or on an external drive) is easily accessible. To order a Windows Vista
operating system DVD, go to http://www.hp.com/support, select your country or region, and follow
the on-screen instructions. You can also order the DVD by calling technical support. For contact
information, refer to the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.
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Backup and recovery in Windows XP
Overview

To protect your information, use the Windows® Backup utility (select models only) to back up files and
folders or create recovery points. In case of system failure, you can use the backup files to restore your
computer.

Windows provides the following options:

● Backing up individual files and folders

● Backing up all files and folders

● Scheduling automatic backups

● Creating recovery points

● Recovering information

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information 
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up individual files or folders to an optional external hard drive or to a network drive.

Note the following when backing up:

● Store personal files in the My Documents folder, and back it up periodically.

● Back up templates stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen you want to save.

b. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, click Edit > Paste.
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The screen image is added to the document.

d. Save the document.

To create a backup using the Windows Backup utility (select models only), follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Click Start > All Programs > Accessories > System Tools > Backup.

2. Follow the on-screen instructions.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools (select models only): You can use the Windows Backup utility to recover
information you have previously backed up.

● Operating System and Driver Recovery discs (included with your computer): You can use the discs
to recover your operating system and programs installed at the factory.

Recovering your information

To recover information you previously backed up, follow these steps:

1. If possible, back up all personal files.

2. Click Start > All Programs > Accessories > System Tools > Backup.

The Backup or Restore Wizard opens.

3. Click Restore files and settings, and then click Next.

4. Follow the on-screen instructions.

NOTE: For additional information on initiating a recovery in Windows, perform a search for this
topic in Help and Support.

Recovering the operating system and programs

CAUTION: The recovery process reformats and completely erases the hard drive. All files you have
created and any software installed on the computer are permanently removed. The recovery process
reinstalls the original operating system, software, and drivers. Software, drivers, and updates not
installed by HP must be manually reinstalled.

To recover your operating system and programs, follow these steps:

1. If possible, back up all personal files.

2. Insert the Operating System disc into the optical drive.

3. Shut down the computer.

182 Chapter 7   Backup and recovery



4. Turn on the computer.

5. Follow the on-screen instructions to install the operating system.

6. After the operating system is installed, remove the Operating System disc and insert the Driver
Recovery disc.

7. Follow the on-screen instructions to install the drivers and programs.
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Linux backup and recovery
Use the instructions in this section if SUSE Linux SLED 11 is installed on your computer.

To protect your information, back up your files and folders. Then if the system fails, you can restore
your important files from copies. You can also use the options listed in this section to restore the
operating system and programs that were installed at the factory.

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The f11
recovery tool reinstalls the original operating system and HP programs and drivers that were installed at
the factory. Software, drivers, and updates not installed by HP must be manually reinstalled. Personal
files must be restored from a backup.

To recover the original hard drive image using f11, follow these steps:

1. If possible, back up all personal files.

2. Restart the computer, and then press f11 while the “Press <F11> for recovery” message is
displayed on the screen.

3. Follow the on-screen instructions.
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8 Connector pin assignments

1394

Pin Signal

1 Power

2 Ground

3 TPB-

4 TPB+

5 TPA-

6 TPA+

Audio-in (microphone)

Pin Signal

1 Audio signal in

2 Audio signal in

3 Ground
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Audio-out (headphone)

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground

External monitor

Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock
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RJ-45 (network)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused

RJ-11 (modem)

Pin Signal

1 Unused

2 Tip

3 Ring

4 Unused

5 Unused

6 Unused
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Serial (select models only)

Pin Signal

1 1 Data carrier detect

2 Received data

3 Transmitted data

4 Data terminal ready

5 Signal ground

6 Data set ready

7 Request to send

8 Clear to send

9 Ring indicator

Universal Serial Bus

Pin Signal

1 +5 VDC

2 Data

3 Data +

4 Ground
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9 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions
Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China COC 5

South Korea EK 4

Sweden SEMKO 1

Switzlerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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10 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Caution must be exercised when removing and
handling the backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the
backlight. When you remove these components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly
that might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or
see the Electronic Industries Alliance (EIA) Web site at http://www.eiai.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this chapter are general disassembly instructions. Specific details,
such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one
computer model to another.
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Perform the following steps:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel 3.
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter 2.

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.

194 Chapter 10   Recycling



15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

17. Remove the backlight frame from the display panel.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

Display 195



18. Remove the backlight from the backlight frame.

19. Disconnect the display cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.

196 Chapter 10   Recycling



Index

Symbols/Numerics
1394

connector pinout 185

A
AC adapter, spare part

number 53
AMT options

AMT setup prompt
(CTRL-P) 150

firmware progress event
support 150

firmware verbosity 150
terminal emulation mode 150
TYPE-131 in SMBIOS 150
unconfigure AMT on next

boot 150
USB key provisioning

support 150
audio, product description 5
audio-in jack

connector pinout 185
audio-out jack

connector pinout 186

B
backing up

Windows Vista 177
Windows XP 181

Backup and Restore 174, 175
Backup and Restore

Center 177, 178
battery

removal 72
spare part numbers 54, 72

BIOS administrator
password 154, 162

Blu-ray ROM DVD±R/RW
SuperMulti Drive, spare part
number 51

Blu-ray ROM with LightScribe DVD
±R/RW SuperMulti DL Drive

specifications 171
Bluetooth module

removal 74
spare part number 74

boot options 148, 156, 164
boot order 148, 156, 164
built-in device

ambient light sensor 149
Bluetooth device

radio 149, 157, 165
embedded

WLAN 149, 157, 165
fingerprint reader 149
integrated

camera 149, 157, 165
LAN/WLAN

switching 149, 157, 165
microphone 157, 165
modem 149, 157, 165
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(LAN) 149, 157, 165
Notebook Multibay 149
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options 157, 165
Wake on LAN 149, 157, 165
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button 149, 157, 165
WWAN device

radio 149, 157, 165
built-in device options 149
buttons

pointing stick 18
power 19, 21
TouchPad 18

buttons and fingerprint reader
components 19

C
Cable kit

contents 50
spare part number 50

cables, service considerations 66
chipset, product description 2
components

bottom 32
buttons and fingerprint

reader 19
display 15, 30
front 25
left-side 28
pointing device 18
pointing devices 18
right-side 27

computer feet
locations 71
spare part number 71

Computer Setup
accessing 151, 159
Diagnostics

menu 147, 155, 163
File menu 146, 153, 161
navigating and

selecting 144, 151, 159
restoring factory

settings 145, 152, 160
Security menu 154, 162
System Configuration

menu 148, 156, 164
using 151, 159

computer specifications 167
connector pinout

1394 185
audio-in jack 185
audio-out jack 186
external monitor port 186
headphone 186
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microphone 185
monitor port 186
network jack 187
RJ-45 jack 187
Universal Serial Bus (USB)

port 188
connectors, service

considerations 66

D
device

configurations 148, 156, 164
Diagnostics menu 147, 155, 163
discs

Driver Recovery 182
Operating System 182

Disk Sanitizer 154, 162
diskette drive

precautions 66
display assembly

removal 109
spare part numbers 109

display bezel, spare part
numbers 48

display enclosure, spare part
numbers 49

Display Hinge Kit, spare part
number 49

display specifications 168, 169
docking, product description 7
DriveLock

automatic 154, 162
password 154, 162

Driver Recovery disc 182
drives

boot order 156, 164
drives, boot order 148
drives, preventing damage 66
Dual Core CPU 149, 157, 165
DVD-ROM Drive

specifications 173
DVD±RW SuperMulti Double-Layer

Drive
specifications 172

DVD±RW SuperMulti with
LightScribe Drive, spare part
number 51

E
electrostatic discharge 67

embedded numeric keypad 17
error log 147, 155, 163
esc key 16, 17
Ethernet, product description 6
Execution Disable 148, 156, 164
external media cards, product

description 7
external monitor port

connector pinout 186

F
f11 recovery 179
fan

removal 102
spare part number 102

feet
locations 71
spare part number 71

File menu 146, 153, 161
fn key 16, 17
function keys 16, 17

G
graphics, product description 2
grounding equipment and

methods 69

H
hard disk test 147, 155, 163
hard drive

precautions 66
removal 75
spare part numbers 51, 75
specifications 170

hard drive recovery 179
headphone jack

connector pinout 186
heat sink

removal 104
spare part numbers 104

hinge, spare part number 49
HP QuickLook 2 149, 157, 165
HP SpareKey

enrollment 154, 162

I
integrated numeric keypad 16

K
keyboard

product description 8

removal 88
spare part numbers 88

keys
embedded numeric keypad 17
esc 16, 17
fn 16, 17
function 16, 17
integrated numeric keypad 16
Windows applications 16, 17
Windows logo 16, 17

L
LAN Power Save 148
language, changing in Computer

Setup 148, 156, 164
legacy support,

USB 144, 148, 151, 156, 159
, 164

lights
power 22, 24
wireless 22, 24

M
mass storage devices

product description 4
memory module

product description 4
removal 78, 91
spare part numbers 78, 91

microphone
product description 5

microphone jack
connector pinout 185

model name 1
modem jack, pin

assignments 187
modem module

removal 128
spare part numbers 128

modem, product description 5
monitor port

connector pinout 186

N
network jack

connector pinout 187

O
Operating System disc 182
operating system, product

description 10
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optical drive
product description 5
spare part numbers 51
specifications 171, 172, 173

P
packing guidelines 68
palm rest

removal 98
spare part numbers 98

panels, product description 3
parallel port mode 148
passwords 154, 162
pin assignments

modem jack 187
RJ-11 187

plastic parts 65
Plastics Kit

contents 52
spare part number 52

pointing device
components 18
product description 8

pointing stick 18
port options

1394 port 150
ExpressCard

slot 150, 157, 165
flash media

reader 150, 157, 165
parallel port 150
serial port 150
Smart Card slot 150
USB port 150, 157, 165

ports
product description 7

power button 19, 21
power button board

removal 96
spare part number 96

power connector cable
removal 140
spare part number 140

power cord
set requirements 189
spare part numbers 53, 54

power lights 22, 24
power requirements, product

description 8

processor
removal 107
spare part numbers 107

processor, product description 1
product description

audio 5
chipset 2
docking 7
Ethernet 6
external media cards 7
graphics 2
keyboard 8
mass storage devices 4
memory module 4
microphone 5
modem 5
operating system 10
optical drive 5
panels 3
pointing device 8
ports 7
power requirements 8
processors 1
product name 1
security 9
serviceability 13
webcam 5
wireless 6

product name 1

R
RAID (Redundant Array of

Independent Disks) devices 148
recovering 176
recovery partition 179
removal/replacement

preliminaries 65
procedures 70

restore security
defaults 150, 158, 166

restore the factory
settings 146, 153, 161

restoring the hard drive 179
RJ-11 (modem) jack

pin assignments 187
RJ-45 jack

connector pinout 187
RTC battery

removal 93
spare part number 93

run-in test 147, 155, 163

S
SATA (Serial Advanced Technology

Attachment) devices
AHCI (Advanced Host Controller

Interface) 148, 156, 164
IDE (Integrated Drive

Electronics) 148, 156, 164
Screw Kit, spare part number 53
Secondary Battery Fast

Charge 149
Security menu

allow reset of HP ProtectTools
security keys 154, 162

always prompt for HP SpareKey
enrollment 154, 162

Automatic DriveLock 154, 162
change password 154, 162
Disk Sanitizer 154, 162
DriveLock 154, 162
HP Sparekey 154, 162
HP Sparekey

enrollment 154, 162
password policy 154, 162
set up BIOS administrator

password 154, 162
System IDs 154, 162
user management 154, 162

security, product description 9
serial number 34
service considerations 65
service cover

spare part number 94
service tag 34, 70
serviceability, product

description 13
set security level 150, 158, 166
setup utility

Diagnostics
menu 147, 155, 163

File menu 146, 153, 161
navigating and

selecting 144, 151, 159
restoring factory

settings 145, 152, 160
Security menu 154, 162
System Configuration

menu 148, 156, 164
SIM, removal 73
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speakers
removal 130
spare part number 130

specifications
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Drive 171

computer 167
display 168, 169
DVD ±RW and CD-RW
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Drive 172

DVD-ROM Drive 173
hard drive 170
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static-shielding materials 69
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menu 148, 156, 164

system date and
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menu 147, 155, 163

system fan 148, 156, 164
system IDs 154, 162
system

information 146, 153, 161

T
tools required 65
top cover

removal 121
spare part numbers 121

TouchPad
location 18
removal 100
spare part numbers 100

TouchPad button 18
transporting guidelines 68
TXT (Intel® Trusted Execution

Technology) 149

U
Unified Extensible Firmware

Interface (UEFI)
mode 149, 157, 165

Universal Serial Bus (USB) port
connector pinout 188

USB legacy
support 144, 148, 151, 156
, 159, 164

USB/Card Reader board
removal 134
spare part number 134

V
Virtualization

Technology 149, 157, 165

W
webcam panel, spare part

numbers 49
webcam, product description 5
Windows applications

key 16, 17
Windows Backup

utility 181, 182
Windows logo key 16, 17
Windows recovery 178, 182
Windows Vista operating system

DVD 180
wireless lights 22, 24
wireless module, product

description 6
WLAN module

removal 80
spare part

numbers 54, 55, 56, 80
workstation guidelines 68
WWAN module

removal 84
spare part number 54, 84
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